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Limited warranty

IMPORTANT—PLEASE READ THIS LIMITED WARRANTY CAREFULLY TO UNDERSTAND YOUR RIGHTS AND
OBLIGATIONS! The term “Hardware Device” means the Bridge Systems hardware product. The term “You” means
either an individual or a single legal entity who will be referred to in this Limited Warranty as “You” and “Your”.

A. WARRANTIES.

1. Express Warranty. Subject to the terms and conditions of this Limited Warranty and in lieu of any other (if
any) express warranties, Bridge Systems warrants that under normal use and service, on the date of acquisition as
shown on Your receipt or similar proof of payment and for the period of time stated below for the applicable
Hardware Device (hereafter each defined as the “Warranty Period”), that the Hardware Device will substantially
conform with the accompanying Bridge Systems packaging and documentation. As to any defects discovered after
the Warranty Period, there is no warranty or condition of any kind.

Warranty Period:
For all hardware parts of the Bridgemate Scoring System: two (2) years.

This Limited Warranty does not cover, and no warranty of any kind is provided with respect to any subjective or
aesthetic aspects of the Hardware Device. The express warranty stated above is the only express warranty made to
You and is provided in lieu of all other express or implied warranties and conditions (except for any nondisclaimable
implied warranties that exist), including any created by any other documentation or packaging. No information or
suggestions (oral or in a record) given by Bridge Systems, its distributors, agents, affiliates or suppliers or its or their
employees or agents, shall create a warranty or condition or expand the scope of this Limited Warranty.

2. Limitation on Duration of Implied Warranties. If you are a consumer, You may also have an implied warranty
and/or condition under the laws of some jurisdictions, which is hereby limited to the duration of the Warranty Period.
Some jurisdictions do not allow limitations on how long an implied warranty or condition lasts, so the foregoing
limitation may not apply to You.

B. EXCLUSIVE REMEDY. Subject to applicable law and the following, and provided that You return the
Hardware Device to Your place of acquisition (or, if that place will not accept the return, to Bridge Systems) with a
copy of Your receipt or other bona fide proof of payment during the Warranty Period, Bridge Systems will, at its
option and as Your exclusive remedy for breach of this Limited Warranty and any implied warranties:

repair or replace the defective Hardware Device; or make payment to You for the allowable damages that You
incurred in reasonable reliance, but only up to the amount You paid (if any) for the Hardware Device less reasonable
depreciation based on actual use.

The above remedy is subject to the following:

Any repaired or replaced Hardware Device will be new or refurbished or serviceably used, comparable in function
and performance to the original Hardware Device, and may include third party items;

Any Hardware Device repaired or replaced under this Limited Warranty will be warranted for the remainder of the
original Warranty Period or 30 days from the date of shipment of the item back to You, whichever is longer.

Except as otherwise required by legislation in Your jurisdiction, costs associated with transport (including packaging)
for warranty service shall be at Your expense; and Bridge Systems, its distributors, agents, affiliates and suppliers do
not provide any warranties regarding any other services provided under this Limited Warranty and disclaim all duties
(if any) of workmanlike effort or of lack of negligence regarding such services.

C. NO OTHER WARRANTIES. The express warranty stated above is the only express warranty made to You
and is provided in lieu of all other express or implied warranties and conditions (if any) including any created by any
other documentation or packaging. No other warranties or conditions are made with respect to the Hardware Device
or the warranty services by any person, including but not limited to Bridge Systems, its distributors, agents, affiliates
and suppliers. No information (oral or written) or suggestions given by Bridge Systems, its distributors, agents or
suppliers or its or their employees, shall create a warranty or condition or expand the scope of this Limited Warranty.
Also, there is no warranty or condition of title, quiet enjoyment, or noninfringement in the Hardware Device. You may
have greater rights existing under legislation in your jurisdiction.
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D. EXCLUSION OF OTHER DAMAGES.

TO THE FULL EXTENT ALLOWED BY LAW, BRIDGE SYSTEMS AND ITS DISTRIBUTORS, AGENTS,
AFFILIATES AND SUPPLIERS ARE NOT LIABLE FOR ANY:

(i) CONSEQUENTIAL OR INCIDENTAL DAMAGES;

(i) DAMAGES OR LOSS OF ANY NATURE WHATSOEVER RELATING TO LOST PROFITS, BUSINESS
INTERRUPTION, LOSS OF DATA OR PRIVACY OR CONFIDENTIALITY, ANY INABILITY TO USE ALL OR PART
OF THE HARDWARE DEVICE, PERSONAL INJURY, OR ANY FAILURE TO MEET ANY DUTY (INCLUDING BUT
NOT LIMITED TO ANY DUTY OF NEGLIGENCE, GOOD FAITH OR OF WORKMANLIKE EFFORT); OR

(iii) INDIRECT, SPECIAL, OR PUNITIVE DAMAGES ARISING OUT OF OR RELATING IN ANY WAY TO THE
HARDWARE DEVICE. THE FOREGOING APPLIES EVEN IF BRIDGE SYSTEMS OR ANY DISTRIBUTOR,
AGENT, AFFILIATE OR SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSSES OR
DAMAGES; AND EVEN IN THE EVENT OF FAULT, TORT (INCLUDING NEGLIGENCE), STRICT OR PRODUCT
LIABILITY, MISREPRESENTATION OR OTHER REASON.

Some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusions may not apply to You.

E. EXCLUSIONS FROM COVERAGE. This Limited Warranty shall not apply and Bridge Systems, its
distributors, agents, affiliates and suppliers have no liability under this Limited Warranty if the Hardware Device:
- is used for commercial purposes (including rental or lease);

- is modified or tampered with;

- is damaged by Acts of God, power surge, misuse, abuse, negligence, accident, wear and tear, mishandling,
misapplication, or other causes unrelated to defects in the Hardware Device;

- is damaged by programs, data, viruses, or files, or during shipments;

- is not used in accordance with the accompanying documentation and use instructions; or

- is repaired, modified or altered by other than a Bridge Systems authorized repair center and the unauthorized
center causes or contributes to any defect or damage.

F. REGISTRATION. You need not register Your acquisition of the Hardware Device for the Limited Warranty to
be effective.

G. BENEFICIARY. To the extent allowed by applicable law, the Limited Warranty is only made to You, the first
purchaser of the Hardware Device, and there are no third party beneficiaries of the Limited Warranty. It is not
intended for and does not apply to anyone else (except as required by law), including anyone to whom You make
any transfer of the Hardware Device.

H. FURTHER INFORMATION. Bridge Systems is the warrantor under this Limited Warranty. To receive
instructions for obtaining performance of this Limited Warranty You must either contact the local Bridgemate
distributor serving your country, or write to: Bridge Systems BV, Postal Box 21570, Rotterdam, 3001 AN, The
Netherlands, or visit Bridge Systems on the World Wide Web at www.bridgemate.com.

You must also:

1. Submit proof of payment in the form of a bona fide, dated receipt, or invoice (or a copy) evidencing that You are
the beneficiary of this Limited Warranty and that Your request for a remedy is made within the Warranty Period;

2. Follow Bridge Systems’ shipping and other instructions if it determines that all or part of your Hardware Device
requires return. To obtain the Limited Warranty performance, you must take or deliver the item in either its original
packaging or packaging that provides an equal degree of protection to the location specified by Bridge Systems.
Except as otherwise required by legislation in your jurisdiction, costs associated with transport (including packaging)
for warranty service shall be at Your expense.

Failure to follow the above instructions may result in delays, cause you to incur additional charges, or may void your
warranty.

This Limited Warranty gives You specific legal rights and You may also have other rights which vary from jurisdiction
to jurisdiction. Where any term of this Limited Warranty is prohibited by such laws, it shall be null and void, but the
remainder of the Limited Warranty shall remain in full force and effect if its allocation of risks is not materially
disturbed.
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Safety instructions

Important safety warning

Failure to properly set up, use, and care for the Bridgemate system can increase the risk of serious injury or death, or damage to the system.
Read this manual and the manuals of any peripherals for important safety and health information. Keep all manuals for future reference. For
replacement manuals, go to www.bridgemate.us/media/downloads/user-manual-ii.pdf or contact Bridgemate.US.

Select a safe location for the Bridgemate server and scoring devices
If the Bridgemate server or Bridgemate Il scoring devices falls and hits someone, it could cause serious injury. To reduce the risk of such
injuries and damage to parts of the system, set them up according to these instructions and place them on a surface that:
o Isflatand level.
Is stable and not likely to tip over.
Allows all four feet of both the server and scoring device to be in contact with the surface.
Is not likely to allow the server and scoring device to slip or slide off.
Is clean and free of dust and debris.

If the surface or feet of server or scoring devices become dirty or dusty, clean them with a dry cloth.

Arrange all cables and cords so that people and pets are not likely to trip over or accidentally pull on them as they move around or walk
through the area. When the Bridgemate server is not in use, you may need to disconnect all cables and cords from the server to keep them
out of the reach of children and pets. Do not allow children to play with cables and cords.

Do not place any part of the Bridgemate system on a bed, sofa, or other soft surface. Do not place any part near heat sources, such as
radiators, heat registers, stoves, or amplifiers.

Avoid smoke and dust: Do not use the Bridgemate Scoring system in smoky or dusty locations. Smoke and dust may damage the
Bridgemate server and scoring devices.

Insert batteries into the Bridgemate Il scoring devices and server

WARNING Improper use of batteries may result in battery fluid leakage, overheating, or explosion. Released battery fluid is corrosive

and may be toxic. It can cause skin and eye burns, and is harmful if swallowed. To reduce the risk of injury:

Keep batteries out of reach of children.

Do not heat, open, puncture, mutilate, or dispose of batteries in fire.

Do not mix new and old batteries or batteries of different types (e.g., carbon-zinc and alkaline batteries)

Remove the batteries if they are worn out or before storing your Bridgemate system for an extended period of time. When removing

batteries from the Bridgemate or server do not use your fingers or finger nails to remove the batteries; use a blunt object like a

screwdriver or pen to safely remove the batteries.

o |fa battery leaks, remove all batteries, taking care to keep the leaked fluid from touching your skin or clothes. If fluid from the battery
comes into contact with skin or clothes, flush skin with water immediately. Before inserting new batteries, thoroughly clean the battery
compartment with a damp paper towel, or follow the battery manufacturer's recommendations for cleanup.

o  Dispose of batteries in accordance with Local and National Disposal Regulations, including those governing the recovery and recycling
of waste electrical and electronic equipment (WEEE).

Remove batteries aboard aircraft
Before boarding any aircraft or packing Bridgemate scoring devices or server in luggage that will be checked, remove all batteries. The
Bridgemate server and terminals can transmit radio frequency (RF) energy, much like a cellular telephone, whenever batteries are installed.

Do Not Attempt Repairs
Do not attempt to take apart, service, or modify the Bridgemate server, Bridgemate scoring devices, power supply, or its peripherals in any
way. Doing so could present the risk of serious injury or death from electric shock or fire, and it will void your warranty.

Any evidence of any attempt to open and/or modify the Bridgemate system, including any peeling, puncturing, or removal of any of the labels,
will void the Limited Warranty and render the Bridgemate system ineligible for authorized repair.

Disposal of Waste Electrical and Electronic Equipment in the European Union and

other countries/regions with separate collections systems

This symbol on the product or its packaging means that this product must not be disposed of with household waste. Instead,

it is your responsibility to hand this over to an applicable collection point for the recycling of electrical and electronic ——
equipment. This separate collection and recycling will help to conserve natural resources and prevent potential negative

consequences for human health and the environment, which inappropriate disposal could cause due to the possible presence of hazardous
substances in electrical and electronic equipment. For more information about where to drop off electrical and electronic waste, contact your
local city/municipality office, your household waste disposal service, or the shop where you purchased this product.
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Introduction

Thank you for purchasing your Bridgemate® Il scoring system. Bridgemate Il is an advanced electronic scoring
system for bridge clubs and tournaments, designed to enhance the enjoyment of bridge. Bridgemate Il automatically
registers board results. The scores are verified and fed to the central PC. Tournament directors will value the user-
friendly features of Bridgemate I, as it enables them to focus fully on their core tasks.

This manual describes the operation of the Bridgemate Scoring system, including the central software program, the
server and the Bridgemate scoring devices. This manual serves as an addition to the manual supplied with your
scoring program. As the Bridgemate Scoring system operates independently from the scoring program, this manual
includes instructions for operating ACBLscore — but not other scoring programs.

This manual consists of the following chapters:

e The components of the Bridgemate Scoring system are explained in Chapter 1. A brief and concise
explanation is given of the individual components and how they relate to each other.

e Chapter 2 explains how to configure and install the Bridgemate Il software and hardware and how to configure
the Bridgemates per section and table. This chapter also explains how to set the radio channels to enable
wireless data exchange.

o Chapter 3 explores the use of the Bridgemate Control Software in more detail.

e Chapter 4 explains the different Bridgemate Control Software options offered by the Bridgemate Il server.

e Use of the Bridgemate Il scoring devices is explained in Chapter 5.

o Chapter 6 highlights the additional functions for the Bridgemate.

e Chapter 7 contains tips on how to operate the Bridgemate Il scoring system when multiple bridge clubs are
playing simultaneously in one room. Practical advice is also offered on how to deploy Bridgemate Il in big
tournaments, involving different rooms and/or multiple servers.

o Chapter 8 describes using the Bridgemate system with ACBLscore.

Version numbers
This manual covers the following versions of the Bridgemate 1l components:

Normal software/firmware versions

Bridgemate Control Software 3.9.6 Note: Will not install on Windows XP or Vista computers.
Windows XP & Vista may only use older BCS versions.

: 3.7.19 is recommended.

Bridgemate USB server 3.1.1d (firmware version)

Bridgemate Il scoring devices 3.1.1 (firmware version)

Team games in North America

North American team games are uniquely organized — as compared to the rest of the world. The November 2018
softwre and firmware has been released for use by team-game scoring programs (other than ACBLscore) that have
been written for use in North America using Bridgemates for entering results of boards played. Features are:

e Allow teams to move across sections and EW pairs returning to their home table.
e Team players enter their numbers at a home table and review their names before starting round 1.
e EW pair return to home table to compare results on Bridgemates and get team’s next-round assignments.

Download Software and Firmware
Bridgemate software and firmware as well as installation instructions may be downloaded from www.bridgemate.us

Notes:
Bridgemate Control Software (BCS) 3.1.2 and later versions are compatible with Windows 10.
Windows .NET framework 4.0 (or later) is required to install BCS. If Windows .NET framework software is required
on your computer, BCSsetup3-2-6 and later will automatically install it. The Microsoft .NET framework files are
available at:
e Windows XP:
https://www.microsoft.com/en-us/download/details.aspx?id=17718

e Windows Vista SP2, Windows 7 SP1, Windows 8/8.1: Windows 10
https://www.microsoft.com/en-us/download/details.aspx?id=42642
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Chapter 1: Bridgemate Il scoring system Description

This chapter describes the components of the Bridgemate Il scoring system and how they relate to each other. It
also explains how to use the Bridgemate IlI: from creating a session in your scoring program to registering the scores
in the scoring program.

Please read this chapter carefully. Once you understand the function of the individual components and how they
relate to each other, you will quickly get to grips with the Bridgemate Il scoring system.

Description of components
The Bridgemate 1l scoring system consists of the following hardware and software:

e Bridgemate Il scoring devices
e Bridgemate Il server + USB cable
e Bridgemate Control Software
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Bridgemate Il Scoring Device Bridgemate Il Server + USB Cable

Bridgemate Il scoring devices

The Bridgemate 1l scoring devices are placed on the bridge table and are used to enter the results. For the purpose
of simplicity, we shall refer to these input devices as "Bridgemates”. Wireless communication between the
Bridgemates and the server is established and maintained using radio frequency waves. Only one Bridgemate is
required per table. The use of the Bridgemates is explained in more detail in Chapter 5.

Bridgemate Il server

The Bridgemate Il server, “server” for short, is a small device connected to the PC. It acts as a bridge between the
PC and the Bridgemates. As the PC cannot communicate directly with the Bridgemates, the server is a vital
component. The server is equipped with a transmitter and a receiver, establishing and maintaining wireless data
communication with the Bridgemates. The server sends all movement data to the Bridgemates, including board
numbers and pair numbers, and receives the board results in return. The server can control up to 256 Bridgemates
simultaneously. The server connects to the computer using a USB cable.

Bridgemate Control Software

A specific program is required to control the server from the PC: Bridgemate Control Software (BCS). This program
runs on Windows 2000 SP3 or higher and is controlled in part by your scoring program. BCS fully controls the server
and data exchange between the server and the PC. BCS first saves all the relevant session data used by the server
to control the Bridgemates. BCS then retrieves all entered board results from the server and stores these in the
result (.bws) file. All other server controls are also executed from BCS.

In addition, the following three components are important. Although they are not supplied together with your
Bridgemate Il scoring system, they are of crucial importance to the correct operation of the system.

o Client (=Personal computer with Bridgemate Control Software)

e Result (.bws) file

e Scoring program

Client

Bridgemate Control Software runs on a so-called “client” (Windows-based) personal computer (PC). The scoring
program and BCS usually run on one client PC, to which the server is also connected. During big tournaments,
multiple servers may be required to support the high number of Bridgemates and/or to establish and maintain the
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wireless communication between the server and the Bridgemates. In this case, the servers are connected to a
network PC, and the network consists of multiple clients.

Note: The term “client” suggests that the Bridgemate Il scoring system also consists of a PC network server. This is
not the case. All (network) PCs running the Bridgemate Il scoring system are known as clients.

Result (.bws) file

The result (.bws) file is created by the scoring program. It contains all the session data, including sections, tables,
movements, etc. This data is generated by the session configured in the scoring program. BCS reads this session
data and feeds the correct data to the server. During the session, BCS reads all the board results entered in the
server and saves these in the result (.bws) file. All Bridgemate Il result files have the file extension .bws.

Scoring program

The scoring program creates the session and calculates the scores. After you have created a session, the scoring
program will create the abovementioned result (.bws) file. This file contains all the relevant session data. The
scoring program will read all board results saved in the result (.bws) file and process these during the session.
These procedures are explained in more detail in the user manuals or help files of your scoring program.

Procedure

Having examined the individual components of the Bridgemate Il scoring system, the next step involves assessing
the entire process and how the different components relate to each other.

The process is outlined in the below diagram:

Activity Explanation

Step 1: Session created in the This is the starting point in the process. In the session, users can set

scoring program

Step 2: Result file created in the
scoring program

Step 3: Bridgemate Control Software
reads the result file

Step 4: Bridgemate Control Software
(BCS) transfers data to the server

Step 5: The server has been
activated and the Bridgemates can
be activated

Step 6: Scores are entered in the
Bridgemate and sent to the server

Step 7: BCS retrieves the scores from

the server. The scores are saved in the

result (,bws) file

Step 8: The scoring program reads
the scores saved in the result (.bws)
file and adds these to the session

the number of sections to be played, the number of pairs per section,
boards and movements.

Using the session data, the scoring program creates a result (.bws) file,
containing all data relating to the sections, corresponding movements,
boards and pairs.

The scoring program starts BCS. The result file is then read by BCS,
generating the data for all tables used in each session.

BCS initializes the server using the data contained in the result (.bws)
file. All session tables are stored in the server. Movements from each
table are included, so that the server knows (per round) which pairs and
boards correspond with which table.

Now that all the relevant data has been stored in the server, the
Bridgemates can be activated. The players activate the Bridgemates,
which log in to the server. The scores can now be entered.

During this process, the board number and pair number/direction of play
are verified for accuracy. Verification is executed via direct communication
between the Bridgemate and the server. The Bridgemate itself does not
contain any movement data. Entered board results are sent directly to the
server. This data is stored in the server memory.

BCS reads all newly entered scores from the server and saves them in
the result (.bws) file.

The scoring program reads the scores saved in the result (.bws) file and
stores these in its session file. The scores are processed and
incorporated in the session data to calculate the final score.

Automatic launch from your scoring program

If your scoring program fully supports Bridgemate, BCS can execute steps 2 to 4 and read the scores (step 7)
automatically via one simple command from the scoring program. For further information on how to enable
automatic launch of the Bridgemate Il scoring system, please contact the supplier of your scoring program.
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Chapter 2: Hardware configuration

System requirements
Operating system

The Bridgemate Scoring System needs Windows XP SP3 or higher. Microsoft .Net 4 framework must also be
installed. [See Notes — page 4)

Hardware Recommended configuration: Processor Celeron 1.6GHz or higher
Memory 1 GB or higher

Installing Bridgemate Control Software (BCS)

To install the Bridgemate Scoring System, run the current “BCSsetup.exe” file. This software is on the Flash
Drive/Memory Stick from Bridgemate.US; also, it may be downloaded from Bridgemate.US’s website
www.bridgemate.us....download. The requirements for installing BCS software may differ, depending on your
scoring program. For more information about where to install the software on your PC, please consult the
information supplied with your scoring program. To install BCS on a separate client, we recommend the default
folder [C:\Program Files\Bridgemate Pro (32-bit PC’s) or C:\Program Files (x86)\Bridgemate Pro (64-bit PC’s)].
Special Note for Vista, Windows 7, 8 or 10 PC’s: Since Windows 7, 8, 10 and Vista’s security precautions inhibit
writing to any file to the C:\Program Files folder or the “root” C:\,, previous instructions were to configure BCS to save
the Bridgemate Log File elsewhere, e.g., CAACBLSCOR. Starting with version 3.1.2 — the default location for the
Log file is the “User Appdata folder,” therefore, new installations need not change the Log files default location.

See Log File locations on Page 16 for specific details.

Normally, just accept the defaults that are shown during installation.
Installing the server

Install driver and connect USB server
Before connecting the Bridgemate Il USB server to your computer, the driver must be installed!

The server connects to your computer’s USB port using a USB cable. FEirst: If the USB server driver was not
installed by the BCS installation program, run the BM2serverDriverinstallation.exe program on the Bridgemate Flash
Drive or download it www....BM2serverDriverinstall.exe. Second: Connect the server to your computer. Windows
will install the driver — or it may display the New Hardware Found Wizard.; in this case tell the system to search
(browse) and automatically install the driver.

Power supply through USB port and batteries

The server will receive its power supply from your computer through the USB cable. If a USB hub is used, make
sure the hub is powered through an external power supply; otherwise the server may not receive enough or any
power to operate properly.

Batteries

Batteries are used in the event of power failure, for example when the computer is switched off. The Server battery
compartment holds four AA 1.5 volt batteries. Install the four batteries as indicated.

The server obtains its power from the PC through the USB connection. The batteries will only be activated if the
USB port is not supplying power (i.e., when the computer is switched off). If PC power is lost, the server immediately
transfers to the batteries and no data will be lost. We recommend installing batteries as a back-up while the server is
in operation. This will ensure no data is lost during the session. The batteries will operate approximately 50 hours.

Warning
e Always install the batteries as indicated. Incorrectly installed batteries could damage the server and the
batteries. The batteries may start leaking, potentially damaging the server and voiding the warranty.
e When removing batteries from the Bridgemate scoring device or server, do not use your fingers or finger nails
to remove the batteries. Instead use a blunt object like a screwdriver or pen to safely remove the batteries.
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Switching on / off

The server will automatically switch on once the server is connected to the USB port of your computer and the
computer is switched on. To switch off the server, the server must be disconnected from USB power (switch off
computer — or disconnect the server from the computer — and, if batteries are installed, press and hold the small push
button next to “Battery OFF” for a few seconds — until all LEDs are no longer lit.

Status indicators There should always be TWO green LEDs on the top of the server.

The server is equipped with a black
switch and 2 LED status indicators
labeled “USB / battery power” and
“Battery status.”

Center: Green confirms the server is running on USB power from the PC
Red confirms the server is operating on battery power
No light. There is no USB power or data in the server memory.

Lower light:  After connecting the server to a USB port:
Green = sufficient power left.
Orange = batteries are half full.
Red = batteries have less than 25% power left.
Blinking red = immediate battery replacement needed.
No light. No batteries or they are completely drained.

After a game has been completed and
the server disconnected from the PC
press — and hold — the switch to reset
the server which erases all the data
and turns off the battery power.

Automatic power-off

The server is equipped with an automatic power-off function. When the server runs on battery power, and there has
been no activity for a certain length of time, the server will automatically switch off. The default auto power-off time is
1 hour. This can be changed in Bridgemate Control Software in menu Tools - Settings > General.

Setting the region

When BCS is started with a new server attached to the PC, you will be asked to select the correct region. Select
North America. To enable the server to transmit data to the Bridgemates over the correct radio frequency,you must
select the appropriate region. The region setting in the Bridgemates is controlled by the Bridgemate firmware. The
Bridgemate firmware must be for the same region as selected for the server. In other words, the server will be
unable to transmit data to the Bridgemates if the server's region differs from the Bridgemates' region firmware.

Setting the channel

The radio frequency channel over which the server communicates is set to 0 by default. For more information on
how to modify this channel, please see Chapter 4.

Configuring the Bridgemates

See chapter 5 on how to configure the Bridgemates and to put them in use.

Operating instructions

The Bridgemate Il server is very easy to use. Only a few instructions need to be followed. The following rules must
be observed:

o Install the batteries as indicated. Incorrectly installed batteries could damage the server.
During use, make sure the server is placed horizontally on a level surface.
Do not place any objects on the server and make sure there is as much distance between the server and other
objects as possible. The fewer objects there are between the Bridgemates and the server, the better the data
exchange will be.

¢ Where possible, make sure the Bridgemates and the server are not separated by a wall. The server should
preferably be placed in a central location between the Bridgemates. If this is not possible, place the server as
closely as possible to the Bridgemates along the edge of the playing room.

¢ When removing batteries from the server (or Bridgemates) do not use your fingers or finger nails to remove the
batteries; use a blunt object such as a screwdriver or pen to safely remove the batteries. The edge of the
battery door often works very well; but take care not to damage it.



Chapter 3: Bridgemate Control software 9

Chapter 3: Bridgemate Control Software

The Bridgemate Control Software program is the bridge between your scoring program and the Bridgemate system.
BCS reads the session data from the scoring program though the result (.bws) file and loads it into the server so that
the server can control the Bridgemates. Then, BCS retrieves the entered board results from the server and stores
these in the result (.bws) file for posting by the scoring program. BCS has been designed for simplicity and ease of
use and is very user friendly.

This chapter contains information on the basic and advanced functions of BCS. For general program use, it is not
necessary to know all the information contained in this chapter. When first starting the system,be sure to read the
paragraphs “Launching Bridgemate Control”, “Logging in and logging off Bridgemates” and “Board results” first.

Launching Bridgemate Control Software

Bridgemate Control Software is launched from your scoring program. Depending on your scoring program, there are
several ways to launch BCS. The majority of scoring programs have a launching function, enabling fully automatic
activation of the Bridgemate server using the existing and actlve result (.bws) flle For more information, please
consult the manual of your scoring program. G

The active result (.bws) file name is displayed in the title
bar. If no result (.bws) file is open, “No session active”
will be displayed.

Server information

The pane in the top left-hand corner of the screen
displays information relating to the server. If a server has
been found, the text “connected” and the version number
will be displayed. The “battery level” will display the
number of operating hours remaining as a percentage.
BCS will indicate when to replace the batteries. Lastly,
BCS will display the region and the channel being used.

Tables g =
The bottom left-hand corner of the screen lists the tables in the data ( bws) file as created by the scoring program. A
red or green dot indicates the status of the table. Red means that table’s Bridgemate hasn’t been activated yet, or
has finished the session. Green means the Bridgemate has been activated is currently in use.

TD calls
Incoming TD-calls are displayed in the lower left corner of the screen. New TD-calls are displayed in red. Confirmed
TD-calls are displayed in black.

Received board results

All board results read from the server are displayed in the right-hand side of the screen. For each hand/board
played, the table[s], pair numbers, declarer, contract, tricks made or set and the exact time the board result was
saved in the result (.bws) file are displayed. BCS logs the time/date when the server was read and the board result
was saved in the result (.bws) file. The system does not log the time/date when the hand was actually registered in
the server.

Board monitor and round monitor

To provide the director with up-to-date information on the progress of the session, a round and a board monitor are
available. The round monitor shows how many scores have been recorded for each table in each round. The board
monitor shows how many scores have been recorded at each board for each table. Both monitors are updated in
realtime when new results come in.

Result matrix
The result matrix shows the results conveniently arranged. A quick glance tells you which scores are recorded per
board or table. The matrix has different viewing orientations which can be controlled from the Options menu.

Players
This tab shows the member numbers as they are entered on the Bridgemates, and the names of the players — as
found in the local database (loaded from ACBLscore initially) or tournament database (pre loaded in BCS options).
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Filtering and sorting board results
The multi-criteria filtering and sorting functions are in the bottom right-hand of the screen. This enables fast searches
for specific boards or to compare results using Section, Table, Round, Board, Pair NS and Pair EW filter/sort options.

Suspicious contracts analysis
The analysis of suspicious contracts detects contracts that may be incorrectly entered on the Bridgemate based on
other contracts and/or makeable contract information.

Logging in and logging off Bridgemates
Logging in Bridgemate

After the corresponding tables have been added to the server, the Bridgemates can be activated.

Once the Bridgemate has been switched on, it will display the main screen with the Bridgemate 1l logo. Press OK to
go to the section and table number screen. Depending on the setting of section and table number entry (see chapter
5), you may be asked to select your section and table number first. Press OK again to log the Bridgemate in to the
server. The flashing symbol in the top right-hand corner of the Bridgemate screen indicates that radio
communication is taking place. Once the Bridgemate has logged in, all first round data will be displayed. In the BCS
screen, the red symbol in the “Status” column of the table list will turn to green. This column also gives a clear
overview of all inactive Bridgemates: if the status column is still red, the table has not activated its Bridgemate.

In the following cases, the Bridgemate will not be logged in to the server, but instead the message “SYSTEM NOT
ACTIVATED YET” will be displayed and the Bridgemate is returned to the main screen:

The Bridgemate Scoring system has not been started yet by the scoring program.

The corresponding table has not been added to the server.

The server and the Bridgemate are not communicating over the same channel.

The region setting in BCS does not match the region setting of the Bridgemates.

The server is outside the range of the Bridgemate and cannot communicate with the Bridgemate.

Two other messages may be shown as an indication that the Bridgemate cannot start the session:
e “TABLE STARTED BY ANOTHER BRIDGEMATE"
Another Bridgemate with the same section/table number setting has already logged in to the server. It is not
possible for two Bridgemates to log in with the same section/table number.
e “END OF SESSION”
The session of this table has finished, all scores have been registered for this table.

Logging off Bridgemate

The “End of session” message is displayed on Bridgemates that have completed all rounds and sent all the results.
These Bridgemates are returned to the “Bridgemate 11" main screen and are automatically logged off from the server.
The status column of this table will turn red again, indicating that the session has been completed on this table. A
clear overview is given of all the active tables. All Bridgemates with the green status display are still in use.

As well as logging off automatically at the end of the session, users are given three alternative options for logging off:
e Using the reset function on the Bridgemate. The Bridgemate is returned to the start-up screen and is logged
off from the server. See chapter 5 for more information on how to reset the Bridgemates from the TD menu.
e In BCS: via menu Server > Show tables, Reset table[s]. See chapter 4 “Overview of tables.”

The latter function can be used if you need to use another Bridgemate for a specific reason but cannot log off via the
normal procedure. A Bridgemate needs to be logged off before it can be replaced. See also chapter 7.

Board results

Reading from the server

Once the Bridgemates have logged in, they will feed data to the server during the session. These results are first
saved in the server. As long as the server is connected, BCS retrieves data every second from the server and
automatically stores it in the result (.bws) file. This is an automatic process and indicated by the following message
in the status bar: “Status: retrieving data from server”.
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If the server is disconnected for a while, all results not yet sent will be retrieved from the server, read and saved in
the result (.bws) file as soon as the server is reconnected. Delayed reading and processing of scores is therefore
possible. Itis advised, however, that the server be connected at all times during the session and BCS is running.

Viewing and filtering or sorting results

Viewing results

Results that have been read and saved in the result (.bws) file are displayed in the right-hand table of BCS. Per
result, an overview is given of the corresponding table, the round, the team, the player declaring the game and the
contract. The registration time and date is also displayed in the result (.bws) file. Remarks are also displayed (“Not
played” = the Bridgemate indicates that the game has not been played; 40%/60% = arbitral score entered in the
Bridgemate).

Go to the menu Tools - Show/hide columns to select the columns you would like to show or hide.

Applying filter or sort order

As more board results are added and displayed, the more time-consuming and difficult it becomes to find or compare
specific scores. Although you will generally use your scoring program for this purpose, it is conceivable that you may
wish to view the registered data in BCS.

To display a specific section of board results, you can apply a filter to the entire list. This filter can be configured at
the bottom of the screen. Enter specific criteria per section, table, round and board number and NS/EW pair number.
It is possible to enter multiple criteria, for example section A, table 1, round 3. Per criterion, enter your filtering
preference - equal to, not equal, equal or less, equal or greater, between - and enter the relevant values. Select
Apply filter to apply the filter. To remove the filter and display all board results, press Reset filter.

The sort function can be used to sort the (filtered) results according to various criteria. Select the criteria and choose
Ascending or Descending for each criteria. Select Apply sort to start sorting the scores.

Round and Board Monitor

Use Round monitor to view the number of boards that have been reported from each table in play. This enables
Directors to identify slow players and visit the table, if necessary. The color of each cell helps visualize the number
of boards played in each round; red = 2 or more boards to be played; = one board remaining; green = all
boards have been played in the round. Board monitor shows which boards have been played at each table.

Result matrix

Another way of viewing the scores is the result matrix. The matrix shows the scores as a grid where the scores are
outlined for each table and board. This provides a quick way to locate/view a specific score.

The grid can be shown in four different formats:

e Boards horizontally, tables vertically Use for Mitchell movements — Typically 7+ tables

e Tables horizontally, boards vertically Use for Mitchell movements — Best for small games

e Boards horizontally, declarer vertically Use for Howell or Mitchell where every pair # is unique

e Declarer horizontally, boards vertically Use for Howell or Mitchell where every pair # is unique
Go to Tools - Options > General (tab) to select the desired method.

Filter ] Sort Suspicious contbracts |
Sus p icious Contracts [¥ Contract declared by both NS and E'w' v Double dummy check v Automatically check re
Incoming contracts can be Conitracts are suspicious when total ticks in NS | | Contracts are suspicious when ticks won
" and E'w excesds: deviates from DD tricks by:
automatically analyzed and marked as o . Cleeh: e
.. . Contracts in suit: 19 4 tricks or more
suspicious when the contract is )
Contractz in NT: 15

suspected to be incorrect. In order to
enable this analysis, go to the tab “Suspicious contracts” on the bottom of the screen:

Suspicious contracts can be analyzed using two different methods:

1. Comparing contracts in NS and EW: Contracts are compared with other contracts on that board. In case a
contract appears in the same suit or no trump in both the N-S and E-W direction, the contracts are marked
suspicious in case the total number of tricks won by N-S and E-W exceeds the specified number. The defaults
are 14 for both suit and NT contracts. You will probably wish to change the numbers; particularly since INT by
NS and 1 NT by EW (total of 14 tricks) are often encountered.
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Example 1: Total tricks for NT contracts is set to 15. 3NT N = 3 and INTx W -2 will not be marked as
suspicious as the total number of tricks is 14 and this does exceed the threshold value.
Example 2: Total tricks for suit contracts is setto 15. 3H S =4 and 2H E = 3 is — in total — 19 tricks and
therefore will be marked as suspicious.
When only one contract is registered in a direction, this contract is marked as suspicious.
When there are two or more contracts in both directions, all contracts are marked as suspicious.

2. Compare contracts against double dummy (makeable contract information.) This check requires hand
records to be available to the Bridgemate system. Hand records must be manually entered by the players or
they can be imported in Bridgemate Control. Each contract is compared with the makeable contract
information and when the total number of tricks deviates from the double-dummy contract analysis by the
specified number of tricks or more, the contract is marked as suspicious.

To enable the analysis, select “Contract declared by both NS and EW” and/or “Double dummy check” and enable
“Automatically check results for suspicious contract”. Incoming contracts will be automatically scanned for any
suspicious contracts. In order to analyze all current results, click the “Check now” button.

Suspicious contracts are displayed in red in the Results and Result matrix pages. If you determine that a contract is
not suspicious, double-click on the result entry and click on “Contract is valid.” The contract now displays in green.

There is a detailed write-up on our website: www.bridgemate.us/media/downloads/suspicious-contracts.pdf

Creating Reports

Hand-record data from BCS's right-hand display may be copied to an external file. For example, this can be used to
create a report that compares the results achieved by the various teams that played each board.
e Go to the menu Tools = Show/hide columns to select the columns to be in the report.
e Select the records by highlighting the first entry for the report — hold the Shift key down and press End or use
the 1 or | key to select the desired records.
e Right click on the highlighted records and select “Copy scores to clipboard.”
e The comma-delimited data may then be “pasted” into an external program (such as Word and Excel).

Note: If the result file (i.e., 070904E.bws) is opened by a different client computer, the results will not be immediately
displayed in the right-hand panel. Follow the procedure shown under Managing tables, Taking over tables from
another client, on page 14.

Result (.bws) file tables may be imported direct into Excel 2007/2010. Data - Get External Data / From Access 2>
change lookup to “All files” = change file extension from .bws to .mdb = Open - select desired table > Open.

Changing and deleting board records

Changing records

Right-click on the record you would like to change and select Edit score. A detail screen will appear displaying all the
score data. You can now edit the result: Declarer is the pair that played the hand; NS/EW is the “declarer” player;
contractis# =C, ¢ =D, ¥ =H, 4 =S, No Trump = NT, double = x, redouble =xx, pass = PASS. Enter a space
between the value of the contract, the contract type and double/redouble. With “American Style” enter the numbers
of tricks taken — or number of tricks down.

If the board result has not yet been posted into ACBLscore, the change can be performed in BCS and then it will be
read into ACBLsciore correctly. However, if the board result has already been posted into ACBLscore, that score will
have to be manually “corrected” in ACBLscore; the score may also be changed in BCS in order to have correct
traveller and percentage information shown on the Bridgemates — and correct results for website displays.

Note that any changes made to the results in the result (.bws) file will be fed back to the server. Bridgemates will
therefore show the edited result in the overview of previous results.

To change a score from the result matrix, double click on the score to display the edit-score window.

Deleting results

To delete a board result, right-click on the entry you would like to delete and select Delete score. To delete multiple
records simultaneously, highlight the first record - hold the Shift key down and use the 1 or | key to select the records
you would like to delete; alternatively, hold the left mouse key down and select records. The result will also be
deleted from the server. A new score can be entered in the Bridgemate.

Note: Deleted records will not be removed from ACBLscore if the result[s] were already posted into ACBLscore.

Scores cannot be deleted through the Result Matrix.


http://www.bridgemate.us/media/downloads/suspicious-contracts.pdf
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Opening, Saving and Closing result (.bws) files

If no result (.bws) file is open in BCS, options are limited. The Session menu is inactive and no server data can be
processed. During normal use of the Bridgemate Scoring System, ACBLscore creates and then F11 &> BMS causes
BCS to read the result (.bws) file. You do not need to open the result (.bws) file or read the relevant session data.
To read other result (.bws) files in BCS, use the Open and Close functions in the File menu.

Opening existing result (.bws) file

Use the File > Open menu to open an existing result (.bws) file. If this result (.bws) file has not been opened
previously on this client, BCS will ask whether the client wants to log in to this result (.bws) file. This step is
necessary to add tables to the client and interact with the result (.bws) file.

Saving existing result (.bws) file.

Select File = Save as to create a copy of the result (.bws) file at a location of your choice, e.g., a USB flash drive.

Closing the result (.bws) file

Select File = Close to close the active result (.bws) file. You can now open another result (.bws) file.

Using multiple clients

In ordinary club sessions all scoring is done of one computer. In large tournaments, however, it may be necessary to
split the session over multiple computers each serving a selection of the tables, while having the scores collected all
in one Bridgemate result (.bws) file. BCS supports multiple clients simultaneously logging in to a single result (.bws)
file and storing scores during the session from multiple Bridgemate servers.

In order to change the program to multiple client mode, go to menu Tools = Options = tab General, and set the
mode to “Tournament”.

The list of tables will now show two tabs: “All tables” and “Client tables”. The All tables tab contains all the tables
stored in the result (.bws) file. These are generally all the tables used in the session. The Client tables tab displays
the tables assigned to the client PC you are currently using. The name of this client is displayed in the bottom left-
hand corner of the screen. The tables must be assigned to a client. If you are using one PC for your sessions, all
tables will be assigned to the same client. In this case, the All tables and Client tables tabs contain the same tables.
If you are using multiple clients, the All tables tab contains all tables in the session; the tables may be assigned to
different clients. The Client tables tab only displays (on both PCs) those tables assigned to that specific client.

The scoring program will create the result (.bws) file for you. By default it is assumed that only one client is used.
The program will automatically assign all tables to the PC you are currently using. You do not need to perform any
manual changes. Manual changes are only required during big tournaments involving the use of multiple clients and
servers.

Adding a client to the result (.bws) file

The result (.bws) file keeps track of which clients are using the result (.bws) file. Your scoring program will
automatically add your client to the result (.bws) file.

If the result (.bws) file has not previously been opened by the client PC (it was created on another PC), this client has
not yet logged in to and cannot use the result (.bws) file. To add a new client to the result (.bws) file, open the result
(-bws) file on the relevant client. Confirm that the client is to be logged in to the result (.bws) file. The result (.bws)
file may now be used.

Managing tables — Tournament (network) mode

Assigning tables to a client

Once a result (.bws) file has been opened, all tables of the result (.bws) file will be displayed. In Tournament
(network) mode the All tables “Client” column will display the currently-assigned Client, or “not assigned” if the table
is not assigned to any client. To assign a table to the client you are currently using, right-click on the table and select
Add to client. To add multiple tables simultaneously, select the table by clicking and holding the left mouse button
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and the Shift key, or use the Select all function to select all the tables. Once the table has been added to the client,
the client name will be stored in the table. You can only assign tables to the client (PC) you are currently using. If
you are using multiple clients in a network, the result (.bws) file will need to be opened manually per client and the
tables added to that client.

Taking over tables from another client

To transfer a table that has already been assigned to another client to your own client, repeat the above procedure.
Right-click on the table and select Add to client. BCS will ask you to confirm whether you would like to take over the
table from another client.

Overview of tables assigned to a client

The client to which the tables have been assigned is displayed in the “Client” column of the All tables tab. The Client
tables tab only displays those tables assigned to the current client.

Removing tables from the client

Click on the Client tables tab for an overview of all the tables added to this client. Right-click on the table you would
like to remove and select Remove from client. The table will now be removed from the client.

Server control

Activating the server

To activate the server, connect it to the client PC and connect the power adapter or fit batteries. Once the server has
been found, specific data will be displayed in the top left-hand corner of the BCS screen and the Server menu will be
activated. You are advised to connect the server before launching BCS.

Resetting the server
The server contains no data when initially connected to a power source. New tables can be added instantly.

If the server contains data which you would like to delete, you will need to empty the server. This is done using the
reset function. Go to Server - Reset. You will be asked to enter a verification number which is displayed on the
screen. This verification number ensures that the server cannot accidentally be reset. Once the correct verification
number has been entered, the server is emptied and all data removed.

Adding tables

The server is activated by adding tables. As soon as a table has been added, the server feeds this data to the
corresponding Bridgemate, which in turn is activated. The Bridgemate cannot operate if the corresponding table has
not been added to the server. Tables can only be added once to the server. If you attempt to add a table that has
already been added to the server, an error message will be displayed.

To add a table to the server, go to the Client tables tab, select the relevant tables, right-click on one of the tables and
select Add to server. The tables will now be added one by one to the server, and the corresponding movement
loaded per table. An overview of the added tables will be displayed.

Removing tables

It is also possible to remove tables from the server using the Client tables tab. Select the tables you would like to
remove, right-click on these tables and select Remove from server. The tables will now be removed. You will not be
able to use any Bridgemates that are configured to these tables.

Synchronizing the server and client e | o
¥ Detete Lo o sssrve wobech e el

All data relating to the tables is saved separately in both the result (.bws) file and el

the server. In the event of a temporary disconnect between the server and i

the PC, there can be discrepancies between the server and the result (.bws) file. :

These discrepancies can be rectified using the Session - Synchronize / recover Ik amriemink s

menu function.  Siaon

Check the relevant options to indicate your synchronization preferences. . —

You must determine whether to synchronize the server to the result (.bws) file, or [y | it

whether to update the results (.bws) file using the data stored in the server.
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Tables in server which are not in client

Use this option to determine what to do with tables stored in the server but not assigned to the client. To delete
these tables from the server, select “Delete from server”. To add them to the client, select “Add to client”. Tables
that have already been assigned to another client can only be assigned to the current client if the “Take over from
other client” option has been checked. If this box has not been checked, the tables cannot be added to the client.

Tables in client which are not in server

Conversely, some tables may have been assigned to the client but not to the server. To add these tables to the
server, select the option “Add to server”. To delete these tables from the client, select the option “Delete from client”.
This option also allows you to delete all the tables from the result (.bws) file by checking the “Delete from session”
option.

Delete tables from server which are not in session

The synchronization function will also verify whether the server contains tables not contained in the result (.bws) file.
These are so-called “obsolete tables”. Check the “Delete tables from server which are not in session” option to
delete these tables from the server. If this option is unchecked, these tables will not be removed.

Synchronizing client to server and vice versa

As outlined above, the main function of the synchronization process is to synchronize the client to the server and vice
versa. The default settings of this function are configured to synchronize the client to the server: tables that have
been assigned to the server but not to the client are added to the client, and tables that have been assigned to the
client but not to the server are removed from the client.

These settings will need to be adjusted when synchronizing the server to the client. In this case, delete all tables
from the server that have been assigned to the server but not to the client (select “Delete from server”). Conversely,
add to the server all tables that have been assigned to the client but not to the server (select “Add to server”).

In all these cases, make sure the “Delete tables from server which are not in session” option is checked to delete all
tables that have been assigned to the server but not the result (.bws) file (and therefore not to the session). Should it
transpire that these tables were correctly stored in the server and not in the result (.bws) file, a new result (.bws) file
will need to be created, or the current file updated.

Recovering the server

The Synchronize menu function also offers users the opportunity to fully synchronize the result (.bws) file and the
server. To do this, go to the “Recovery” tab and press the “Recover server” button. All existing data will be deleted
from the server and overwritten with the tables and the data contained in the result (.bws) file. The server is
synchronized with the current position of the result (.bws) file. This function is ideal if the server loses its data and it
is necessary to reconfigure the server with data that has been recorded in the result (.bws) file.

Updating movement in the server

Movement data is assigned to all tables added to the server during the x|
synchronization process. The synchronization function does not [ Select ection .
update the movement data of tables already stored in the server and s G |

which have not been updated. If the movement data of the result
(.bws) file has been synchronized from the scoring program, and the
scoring program does not order BCS to update this data, use the Usde moveren sy [T
Session - Update movement function to update the server with the '

correct movement for these tables.

All sections are checked by default. Uncheck all sections that you do
not wish to update. By default, data is updated from round 1. To
update from a later round, select another round number using the selection option. Press Update now to update the
sections with the correct movement. Any table data belonging to sections that you wish to update will now be
deleted from the selected round onwards. A report will be displayed of the executed operations.

When updating from a later round the option “Erase results from prior ool mevement ta1nS  [EN -

rounds...” will appear. If this is checked, all Bridgemates will start from Erase results from priar rounds and confinue Bridgemates
the selected round. However, this will erase all movement info of the from round 3.

previous rounds and delete all scores from the server for those rounds.

Be very cautious with this functionality. If you only want to move the
Bridgemates to the next round, use the “Close rounds” function.

Update now ‘
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Note: The scoring program normally updates all movements in BCS automatically. It is, therefore, not necessary to
invoke this function manually.

:
C|OS|ng roundS Select sections——————
If a Bridgemate hasn't received all the scores of a round and it needs to be moved on the R

next round, for example due to late play or when players didn’t enter their score in the
Bridgemate, you can simply close the round in BCS and force all Bridgemates to move on
to the next round. Go to menu Session - Close rounds.

Close round 1 to: [ =]
Select the sections of which you want the Bridgemates to move on, and select the number
of round you wish to close. For example, if you want all Bridgemates of section B to move
on the 4" round, then select only section B by deselecting the other sections, set close
rounds 1 till 3 (not 4!), and press “Close rounds”. All missing scores up to round 3 for all
tables of section B will be filled up with Not played, and this will also appear in the result list and result matrix.

Bridgemates of section B which are still in round 3 will automatically move on to round 4.
Program Settings (Options)

{Gerieral | View | Fie locations | Seoring program |
Change program functions using menu Tools - Options -2 General.

LCloge rounds

Mode
@ Club [single computer]

Program settings

I~ Closs progiam at end of session

" Loumament [network) ¥ Erase original rscords of delsted scores

To disable the automatic server detection while the program is
running, check Disable server detection. You may wish to do this
when BCS is running without a server connected. During sessions,
however, you are always advised to leave this function unchecked

[ Show Bridgemate aptions when starting new session

]

To close BCS automatically at the end of a session, check “Close
program at end of session.” This requires that all tables — at least

time during the session — have been logged in (with their statysndicators green) and, at end of the session, all
tables have finished and are logged off.

Autopower-off perioct

7 hour A

The Erase original records of deleted stores is required when using ACBLscore.

To view the Bridgemate settings before the Bridgemate system is actually started, check “Show Bridgemate options
when starting new session.” This allows the TD to verify if all settings are correct and make changes where needed
— before the movement is actually loaded into the server.

General [ Visi 1| File locations | Seering program |

View (tab)
When ACBLscore updates the movement, the result is shown on the

Display Fesult matrix

BCS screen through a report window. You may manually close this
report, or it will close automatically after 60 seconds.

“American Style” should be displayed for North American operation.

Result matrix display options are discussed in Chapter 8.

[ Shows 1eport when movament updated by
enternal program

Besults in Bridgemate Control are displayed using
notation;

American styls Bl

Show result matin as:
" Board / table
@ Table / board
" Board / declarer
" Declarer / board

Shaw conliact / score points

Options - General
General | View | File locations [ Scorr

Log files

" BMPro.exe program folder
& User appdata folder

© Other folder:

_ Sckdigd |

BMPlayerDB. mdb database file
" BMPro.exe program folder
& User appdata folder

" Other folder:

_ Sckdigd |

Bridgemate profiles and pager settings
" BMPro.exe program falder

& User appdata folder

© Other folder:

[ selectioier |

" Only contracts

" Dnly seore paints

" Conliacts and score points

File locations (tab)

The default “Log files” location is the “User Appdata folder.” Note, this is hormally a Windows®

hidden folder. Should you wish to use a “non-hidden” folder, the “Other folder” should be

checked — then use |z 1| to specify a non-“Program Files” folder such as

C:\ACBLSCOR. Do VACBLSCOR to use as the log-file location.

Special Note: When BCS is being used by more-than-one Windows® User, a single log file
may be desired. If so, configure each User’'s BCS options to use the same “Other fold

r.

Tools | Help

The folder with all log files may be accessed in BCS - Tools - Open log folder.

Show/hide columns

Show log file

The special BMPlayerDB.mdb player-name lookup file for the National Tourna-
ment (or large local) database will be located in the hidden “User Appdata folder.”

Clear log file
Open log folder

When there are multiple Windows® Users expecting to use the special BMPlayerDB.mdb lookup
file, special arrangements are required.
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General] Wiew ] File locations ~ Scoring program |Scoring metl

Scoring Program (tab) and Player Database

Scoring program specific options

Normally ACBLscore is selected as the scoring program; also, check the “Load SR I
player database after BMS command.” This works well when your “local” (Club h '
mode) database is not too large; i.e., perhaps no more than 10 to 15,000

names. Club player names:

i i Iv Load player database after BbS command
Should your ACBLscore program (and player database) be located in a drive e P —
other than the C:\ “root directory,” click on “Change location” so that BCS can Change location

find the database file when it is started from ACBLscore.

To use ACBL'’s very large “Tournament” (or a large “local”) database, click on T
“Load tournament database” to load/update the special BMPlayerDB.mdb file. p  Load toumament detabase |
This action will take several minutes.

. . . « . . . .y Options:
Starting with v3.1.2, BCS may be optioned to “correct missing Sit-out Pair” t0 ——— & ¢oact missing si-out pail number at hal table inround 1
display their names on the Bridgemates. This works well for Mitchell and Howell [ Cotrect Ew moving to other table in round 1

movements — except with Howell, the phantom pair must be EW in round 1. \
When hands are manually dealt by players at the beginning of a game — then EW and the boards are moved, check:

For more information on “names” and “options settings,” visit:http://www.bridgemate.us/how-to-quides/

Scoring Methods (tab)
Live ranking and scores/rankings in the Bridgemate app are calculated by

Ganerall Wigw | File locations | Scoring program | Scoring methads

IMP scoring method

BCS. The scoring method is specified by the scoring program and cannot be Canections far extreme scores
modified in BCS. However, the method of calculating the date score in IMP AN o eorecton Forlexismelszie
scoring can be configured in BCS. Currently, 3 methods are available: 48 T T o, (4B s & BT
1. No correction for extreme scores. All scores are included in the © o mlreme seares, B scores  feave out 10% an
calculation of the date score. (" Leave out 10% of both sides (iactiona)
2. Correction depending on the number of scores on a board: P e ta e e
a. 1to 3 scores: no correction
b. 4to 5 scores: weight of lowest and highest score is 50% CrassIMP scaiing method
c. 6 or more scores: leave out 10% of both sides, rounded % Show total sum of cross IhiPs
upwars to the nearest whole number. (For example: 11 ¥ Shimn aremEe s Cam it
scores leaves out 1.1 scores on both sides which is rounded Crasa IMP anrdod ta A P ]

up to 2 scores from top and from bottom)
3. Leave out 10% of both sides in fractional numbers. (For example: 11 scores leaves out 1.1 scores on both
sides. The lowest and highest score are left out, The next lowest and highest score have a weight of 1 —
0.1 = 0.9 [90%])).

Pager (tab)

The Bridgemate Pager system works fully on-site, and does not need an internet connection or any extra software.
The Bridgemate Pager has its own USB transmitter that is inserted into a USB port on the computer running BCS.
Directors use a pager to receive director calls. There are two different Bridgemate Pagers: a watch pager and a
pocket pager.

More information is available on the Bridgemate.US website: www.bridgemate.us/product/pager/

Bridgemate app (Tools - Options = App settings)

The Bridgemate® App is a personal add-on to the existing Bridgemate Pro or Bridgemate Il Scoring System. By
using the app, during or after the game, players can consult their guide card for the next round settings, review their
scores, view current ranking, see their competitor’'s scores as well as hand records for the boards already played.

The app also offers an interactive analysis tool to provide instructional feedback on your play.

Guide card

Personal Score Sheet

Rankings More information is available on the Bridgemate.US website:
Opponent’s scores www.bridgemate.us/app/

Hand Records

Analysis of your game



http://www.bridgemate.us/how-to-guides/
http://www.bridgemate.us/product/pager/
http://www.bridgemate.us/app/
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Chapter 4. Server functions

Once the server is connected to the PC, the BCS Server menu is active. This menu contains several useful server
functions. It is not necessary to open a result (.bws) file to use these functions.

Overview of tables

Use the Server - Show tables menu to create an overview of the
tables stored in the server.

Per table, the green or red status light indicates whether this table
has logged in to the server, logged off, or has not yet logged in.

To delete a table from the server, select the relevant table[s] and
choose “Delete table[s]”. The tables will be deleted from the
server, as will all the recorded results of these tables.

To log off a table manually, select the relevant table[s] and click
“Log off table[s]”.

Click the “Show scores” button to create an overview of the scores
entered by the Bridgemate. Select the table[s] of which you would
like to see the board results and select this function.

Click the “Retrieve scores” button to move all entered scores for
the selected tables to the result (.bws) file.

Show tables

Tatal numbers of tables in server: 15

Section | Table

Status

A 1

[===n === === = = - = B - o S S S
=l R R R R N - B AN

20000200200

X

Delete table(z] |
Log off table(z] |

Show scores |
Retrieve scores |

Update seftings |
Feset table(s) |

Cloze

When the Bridgemate settings have been modified, they are updated in the Bridgemates by selecting the tables and

pressing “Update settings”.

To force a Bridgemate to reset itself, select the table and log it off from the server. Then, select the table — again —

and click “Reset table[s]”. Upon its next communication with the server, the Bridgemate will reset itself.

Overview of entered scores

The Server > Show all scores menu function displays an overview of all board results entered in the server.
Depending on the number of tables stored in the server, there may be a delay in reading and displaying the data.

Restarting Bridgemate network

The wireless network can be restarted from the server using the function Server > Restart
network. Use this function to solve wireless communication problems between multiple

Bridgemates and the server. This may be done at any time; it does not Interrupt an

Resetting the server

ng.

The Server = Reset menu function resets the entire server and deletes all data in its memory. To avoid accidental
resets, it is necessary to enter a verification number which is displayed on the screen.

Note: Using “Reset” serves the same function as disconnecting the server and pressing the “battery off” switch for 3
or 4 seconds. Thus, for servers that are left connected to the PC between games, this may be used to erase the
current game info from the server's memory — and still save battery power — should be PC lose power (for any period

of time) between games.
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Setting the region

The Bridgemate Scoring System communicates over a
predetermined frequency spectrum. The permitted
frequencies differ per continent. Three continents are
currently supported: Europe, North America and Australia /
New Zealand. When first launching BCS with a new
server attached, you will be asked to select your region.
The server will select the corresponding frequency
spectrum to communicate with the Bridgemates. Typically
you should select “North America” and press “Set.”

Region selection
Regional settingz

Current region: Harth America

Mevs region: |N0lth Amernica j

Europe:
Morth America

Set

E3
Close

To change the regional settings of the server, go to Server - Region selection.

Setting the channel

The server and the Bridgemates must be set to the same channel —[ElREEEEEEN

to communicate with each other. To set the channel on the
server, use the Server 2 Channel selection menu.

The “Current channel” function displays the current channel.
Select the new channel and press “Set”. The new channel has

now been set.

System functions

Update firmware.

Channel settings
Current chatinel: 1]

Mew channel: i ~

Set

Close

The server’s firmware may be updated in the future. If there is an update, download the new firmware from

www.bridgemate.us and follow the instructions carefully.

USB Server Lights
"USB / battery power" LED:

e Green confirms the server is running on USB power from the PC.
e Red confirms the server is operating on battery power with game data in its memory.
e No light. There is no USB power and no data in the server memory.

"Battery status" LED: When server is connected to an active USB port - or there is game data in its memory:

e Green = sufficient power available.

Orange = batteries are half full.

Red = batteries have less than 25% power left.
Blinking red = immediate battery replacement needed.
No light. There are no batteries in the server, or they are completely drained.

Program Shutdown — Power Outages — Change PC

The following website page describes actions that may be taken to recover from these special conditions.:

http://www.bridgemate.us/how-to-quides/during-a-game-program-shutdown-power-outage-change-pc/



http://www.bridgemate.us/
http://www.bridgemate.us/how-to-guides/during-a-game-program-shutdown-power-outage-change-pc/
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Chapter 5;: Use of the Bridgemate® Il scoring devices

The Bridgemate is a small device designed to enhance the enjoyment of bridge for tournament directors and bridge
players alike. The system enables you to enter scores faster than before, and is guaranteed to prevent operator
errors. As well as allowing players to enter board results, the Bridgemate also feeds information to the players, such
as the achieved percentage on the board played, and the traveler overview. We are convinced that tournament
directors and bridge players will appreciate the convenience of the Bridgemate!

Preparing the Bridgemate for use

The Bridgemates are individually packed in compact sturdy cardboard boxes. Each
Bridgemate comes complete with two AA batteries, which must be inserted into the bottom
of the Bridgemate unit. The + and — signs in the casing indicate the insertion direction of
the batteries. Insert the batteries in the direction indicated, close the lid and press the OK
button. Check whether the “Bridgemate II” logo appears. The Bridgemate is now ready
for use.

SHaEas

Exploring the Bridgemate

Large LCD screen for easy entry of scores, viewing results and other information.
Four function keys offering all kind of additional functionality.
Keypad with 25 large keys for easy input of scores and controlling the Bridgemate.

EEFEE
EECEE

IS ENEN Y
EEEFE
Zle e s

The keyboard

The Bridgemate keyboard contains 29 keys. Some of the keys have a dual function.
Keys Explanation

These keys are used to enter numbers in the Bridgemate, for

1t0 9, 10 example board numbers, pair numbers, contract and result. The
10 button is used to enter O (when entering member numbers,
board numbers etc) and to indicate 10 as the lead card.

Oy O 5 NI These keys enable you to indicate the contract & lead card.

+ - Indicates overtricks or downtricks of the result.

= Indicates that the contract has been exactly made.

J,0,K, A Use these keys to specify Jack/Queen/King/Ace as the lead
card.

X, XX Double or redouble.

N/S, E/W Declarer’s direction of play.

PASS Indicates a pass-out.

CANCEL Correct an entry and cancel commands.

OK Confirm an entry.

Function keys 4 functions keys in the top row provide access to all kinds of

additional functionality which is not covered by the 25 keys.

Switching on/off

The Bridgemate does not have a separate on/off button. To switch on the Bridgemate, press the OK button. It is not
possible to switch off the Bridgemate manually. The Bridgemate will automatically switch off after it has been idle for
a while, i.e. no buttons have been pressed. No data will be lost when the Bridgemate switches off. Simply press the
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OK button to continue as before. In other words, you can continue entering scores as soon as the Bridgemate has
been activated again.

The default autopower-off time is set to 20 seconds. This value can be changed to between 5 and 60 seconds. See
chapter 6 for more information.

Activating the Bridgemate (Bridgemate] []

When switching on the Bridgemate Il for the first time, the main screen displays:

Press Ok to start
Battery indicator vall

In the upper left corner there is a small battery indicator. Full batteries are indicated with a full indicator. If the
battery power is extremely low, the battery indicator will show an empty battery and the indicator starts blinking.
Although it is safe to continue using the Bridgemate for several more sessions, it is recommended that you replace
the batteries as soon as possible. The average battery life is approximately 400~500 sessions. However, this
depends largely on the length of each session, the time frame over which these sessions are played, and how the
Bridgemates are stored. Make sure no keys are pressed during storage.

Configuring the Bridgemate

SETUP v3.1.1 — PAGE 1/2. SETUP v3.1.1 — PAGE 2/2.
Before the Bridgemate is put into use the first time, it needs ?igIéONZ EEﬁECT ggm;AggD: 09
; ; ; 5 : -/+
to be configured with the correct settings. Press the SETUH REG 10N - N—AMERICA

function key to access its internal settings menu. Normally.| cHaNNEL: ©
the Bridgemate asks for Setup PIN code; enter one of the LANGUAGE: ENGLISH

following fixed 3-digit Setup codes: 749 or 769.

You can scroll through the menu using the up and down function keys. Use the + or — key to change a setting.
Press the BACK function key to exit the setup menu. Any changes in the settings will then be saved.

Configuring the section and table

Before the Bridgemate can be used in the session, it needs to be configured with a section, table number. There are
three ways to set this information:

e Fixed setting which the players cannot change

¢ Flexible setting which can be changed before the session starts. (SELECT / SELECT mode)

e Flexible setting with selection of available sections only (SCAN / SELECT mode)

SECTION: A

Fixed section and table setting TEELE: 1
A fixed section and table setting allows you to configure the Bridgemate for a specific table,
while not having the risk that this setting is changed by anyone. Once the setting is made, the Bridgemate must be
placed on the correct table that matches the setting. To do so, scroll the focus up or down to “Section”, and use the
+ and - key to adjust the section. Sections range from Ato Z, AA to ZZ and AAA to ZZZ. Once the section has been
set, scroll one line down to table; press CANCEL to delete the current number and use the number keys to set the
table number. Table numbers range from 1 to 511.

The Bridgemate will retain these settings until you next change the section and table number. In other words, these
settings will be retained even after the session has been completed. It is, therefore, not necessary to change the
settings for the next session. All you need to do now is move the Bridgemate to the correct table.

Flexible setting of section and table (SELECT / SELECT mode)
A flexible setting allows you to freely distribute
the Bridgemates over the tables, and upon

start of the session, the Bridgemate will ask SECTION: A LR - (e

the players to confirm the section and table SELECT SECTION PRESS 0K TO START
. o WITH + OR —

number of the table which they are sitting at. PRESS OK TO CONFIRM  PRLGE OR 1o COMCIRM  OR CANCEL TO CHANGE

This method allows you to assign numbers and sections to tables at the very last minute while the Bridgemates are
already placed on the table.

In order to set the flexible setting, scroll the focus up or down to “Section” and press the + or - key until you see
“Select” behind “Section”. “Select” will also be placed behind “Table”. Press BACK function key to accept the
settings and return to the main screen. The Bridgemate is now configured for flexible entry of section and table
number at the start of the session. The Bridgemate can be freely placed on any table in the session.
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Flexible setting with selection of available sections only (SCAN / SELECT mode)

This setting is very similar to flexible setting of section of table, but it limits the CHOOSE YOUR SECTION
selection of section to the sections which have been uploaded to the server. A=1 E=2 C=3
Instead of allowing the player to choose any section ranging from A to ZZZ, only D=4

the sections which are actually being used in the session can be selected.

In Setup, scroll to “Section”, and press the - or + key until “Scan” appears behind “Section” and Select behind Table.
Press the BACK function key to exit the settings menu. The Bridgemate can be placed on any table in the session.

Setting Bridgemate Region and Channel
Use the up and down function keys to move to the “Region” row. Use the + and — keys to select region N-AMERICA..

The Bridgemate Il scoring system can communicate over different radio channels. This enables users to install
multiple systems next to each other without causing interference (see also Chapter 6, “Multiple clubs”). To enable a
Bridgemate to communicate with the server, both must be set to the same region and channel. The default setting
for the Bridgemate and server channel is channel 0. To modify the channel, move to the “Channel” row. Erase any
exisiting channel number with the Cancel key and input the new channel number.

Language Select the language by pressing the + and - keys.

SETUP security code
To protect the setup menu from unauthorized access by players, set the “SETUP COD” to ON using the + or - key.
The preset codes are 749 and 769. Once the Setup code is set to ON, the Bridgemate will ask for “Setup PIN".

Starting the session

Switching on/off
To switch on the Bridgemate, press the OK button. The Bridgemate will automatically switch off after it has been idle

for a while, i.e., no buttons have been pressed. No data will be lost. Press the OK button again to continue.

TAELE STARTED Occasionally another table will log on as the wrong table and players will see this screen. If this
BY_ANOTHER happens, press OK to start the procedure to log on correctly with this Bridgemate — replacing

BRIDGEHHTEO the unit that logged on incorrectly. The ERASE “take-over” feature may be used — at the
FROCEED RS RA17 Press ERASE to erasze

beginning of a game — if one-or-more player names have been entered = 211 Prewicus data.
Fress COMTIM. o

CALL TD TO START

A= TRELE Al or are incorrect. See Chapter 7, page 32, for more information. LA SR FEiein
TO PIM: <— . . previous data.
- This screen will appear. Enter the TD Pin code. When used at the E=E [ orTIn
A beginning of a game, press “Erase” to delete everything entered by the errant table and enable

the correct table to enter their player numbers and results.

Activating the Bridgemate and confirming Section and Table setting

At the start of the session, the Bridgemate will by default display the “Bridgemate 11" main screen. Press OK to view
the table and section settings of the Bridgemate. See Configuring the Bridgemate on page 21. Players choose their
section by pressing the number that corresponds with the section they will play in.

Entering member numbers (optional) ENTER PLAYERS
If BCS or the scoring program is set to enter member numbers, the Bridgemate will ask for the g 32;‘513(2)
four player numbers. Use the number keys to enter the number, and press OK to confirm. E: 7891

If a player does not know his number or does not have one, press OK without entering a w:

number. No number will be registered for this player.
There is a detailedf write-up at: www.bridgemate.us/how-to-guides/names-display/#Names

Joseph Steele
: Henny Dorsman
: Kevin Edwards

Review player names : Name N/A

When the numbers have been entered, the next screen will display the names that BCS finds PRESS OK TO ACCEPT
for the entered numbers. If there is a correction to be made press CANCEL to return to the OR CANCEL TO CORRECT
previous screen in order to apply corrections. The names will be displayed again.

=mwn=z

Enter results with the Bridgemates ROUND 1
; Ms: 1 El: 12
Information before the start of the round BORRDS 1-4

At the start of each new round, the Bridgemate will display the new round, direction of play
and the expected pairs. The board numbers will also be displayed. For example, you can
verify at the start of the round whether you are seated in the correct direction and have the correct boards on the
table. This information is displayed as follows:


http://www.bridgemate.us/how-to-guides/names-display/#Names
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ROUND 1 NSl EW:l2 21-24

Press OK to confirm this screen and continue with the board input. BOARD :
Note: If Player numbers are being displayed, Bridgemate shows the player names again. pONTR -
Entering board results LEAD
The following screen will be displayed when entering the board results:

The information at the top of the screen shows the current round, the pair numbers and
the boards to be played. The flashing line indicates the input position. If the incorrect player numbers have been
displayed, press the NAMES key and make corrections as appropriate.

Entry and verification of board number

Before starting to play the board, enter the board number and press OK to confirm. The Bridgemate will verify the
number. In case the board number is incorrect, or the board has already been played in that round, the Bridgemate
will so notify. It will also mention the boards that are yet to be played.

To assist the players entering the correct board number, two additional features are available which can be enabled
or disabled through the Bridgemate settings (see chapter 6):

e Automatic entry of board number. When enabled, the Bridgemate will automatically fill in the next board
number. Assuming boards are played in order, this reduces the chance of entering a wrong board number.

e Board order verification. When enabled, the Bridgemate will verify if the board number corresponds to the
logical order. If the Bridgemate expects a different board number to be entered, it will ask to confirm that the
boards are played out of sequence. If you do wish to play an out-of-sequence board, press OK. The
Bridgemate will assume that you have chosen to deviate from the logical order. If the board number was
entered wrongly, press CANCEL to return to the previous screen and enter a new board number.

Once the board number has been entered and confirmed, the cursor will jump to the second line. You can now begin
the bidding. As soon as the contract has been determined, enter the contract and direction of the declarer.

Entry of contract and declarer ROUND 1 WS Ebla  @1-ay
To enter the contract, use numbers 1 to 7 and the &, ¢, ¥, A and NT keys. If required, EORRD : 21

you can also use the X and XX keys to indicate double or redouble. To specify the CONTE = BMT = N
declarer, use the N/S and E/W keys. If the declarer is North, press N/S once. If the LERD - _

declarer is South, press this key twice. Alternatively, if the declarer is East or West, RESLIL

press E/W once or twice. The screen is displayed as follows: TOMEHL] m ZCORES]

Entering lead card (optional)

If you have specified in Bridgemate settings that lead cards must be entered, the Bridgemate will ask you to enter the
lead card. If not, this line will not be visible and the input position will jump to RESULT instead. If BCS options are set
to validate the lead card (against known hand records), the validation will be when E (or W) presses the ACCEPT key.

Select the lead card using keys 2 to 9, 10, J, Q, K or A and the suit (strain) using %, ¢, ¥ or a. The suit/denomination
may be entered in any order. See the detailed write-up on our website: Lead-Card Setup-Display-Verify

Entering the result

Once you have finished playing the board, you can enter the result. Using “American Style,” when the contract has
been made enter the number of tricks taken. If the contract was not made, use the — key followed by the number of
tricks “down.” The = key may also be used when the contract has been exactly made.

Depending on the settings in BCS, the result can also be entered as the total number of tricks won (i.e., 0 to 13) or
Up/down tricks. When using Up/down, enter = when the contract has been exactly made, the + key followed by the
number of “overtricks,” or the — key followed by the number of tricks “down.”

Verification by East or West and confirmation of board result
After entering the contract, lead card (if requested) and result, press OK. “Verification by
East or West” will display. Pass the Bridgemate to East or West to verify the result and BOARD 21, BNT= -1

ROUKD 1 HZ:1 Eldild 21l-o4

score points calculated by the Bridgemate. Depending on the Bridgemate option, the by Morth,-200  Cs
score points will be displayed as assigned to the North/South pair or to the Declarer. PPESE.:-&FE:EET to

In a short while, the screen will automatically change and repeat all the information
previously entered by North. The verification screen will for example be displayed as:

East (or West) verifies the data displayed on the verification screen. If this data is incorrect, E/W will press CANCEL
to edit the data. If the result is correct, E/W will press the ACCEPT function key to confirm the result. The message

“Entry completed” will now be displayed. The data is saved and sent to the server. BOUMD 1 WSl EWLE o a1eay
. . . . ENTRY COMFLETE

Overview of percentage achieved and previous results (optional) NS: 752 El: 752

After E/W has confirmed the board result, players have feedback options for viewing their BEOGRDS TO E0: 2

achieved result and board results achieved by other pairs. Depending on the Bridgemate YIEW RESULTS?


http://www.bridgemate.us/media/downloads/lead-card-setup-display-verify.pdf
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settings, the following information can be displayed:

e Overview of scores of other pairs on the entered board

e Achieved percentage for the entered board result
The server calculates the percentage by reviewing other scores registered for the board. The percentage will have
little significance at the start of a session. As the session progresses, percentages will approximate the final result.

Press OK to exit this screen. When the overview of scores of other pairs on the board is enabled, these scores are
displayed. Frequency list indicates the number of times the same result has been recorded, i.e., 3x = 3 times. The
first score is the highest N/S achieved score so far in the session on this board.

Depending on the setting in BCS, the scores can be shown in three different formats: Special Note:
Zx M 4H /A +EED ?; +g jn 5 Egs ?i _}E in 5 :Egs The 1 or 2 score columns
ix S 4H g +650 #x HdH 4 e 4x H 2H 3 +626 display also applies for
dw H AH +H20 1= - ® - b Score Recap — see below.
1= 5 35-1 188 1x = 2=-1 -10@ .
1x: E ZC-1 +80 Zm. H oan-1 168 S H aAb-1 —1@@ 2 columns is recommended.
v | a W | & ] v | ]

4 lines, 1 column. Own score bold. Frequency list 6 lines, 2 columns  Frequency list 6 lines, 1 column. Your own score is shown with >

The display selected here also applies to “Score Recap” — so even if the detail is “grayed

out,” — an option with “2 score columns” should be selected. END OF FOUND 1
End of round Eﬁ _}S%H%I
At the end of the round, the Bridgemate will display the message “End of round”. You do RS

not need to do anything. The Bridgemate will automatically switch off after a few seconds.
Press OK again to begin entering the scores in the next round.

SCORE RECAP — BOARDS 21-24

Show Score Recap Automatically 21:4H N 6 680
If the Tools > Options > Bridgemate > Bridgemate Il & “Show score recap automatically” | 22:3NTxW 3 750
is checked, the results of the boards played at this table during this round will be displayed. ZouZt s el 100

24:6Sx N 6 1210
Show seatings for the next round
At the end of the round, Bridgemate can guide the pairs to their next table[s]. This is shown together with the end of
round message. Seatings for next round information can be enabled from the Bridgemate settings (see chapter 6).

End of session
At the end of the last round, the Bridgemate will display the message “End of session” and return to the Bridgemate Il
main screen after a few seconds. The Bridgemate has completed its tasks and can now be safely stored away.

Special entries: Pass-out and board not played
If the players have passed four times without making any bid, enter ‘Pass’ at CONTR and confirm with OK. You will
not be asked for the lead card and the result; the Bridgemate will switch immediately to the verification screen.

If a board has not been played in a particular round, e.g., due to time constraints, the Bridgemate must be informed.
If this step is skipped, the Bridgemate will remain in the uncompleted round, and other pairs will be prevented from
entering their results. To enter an unplayed board, press the 10 key in the CONTR row. The screen will now display
the text "NO PLAY”. Confirm by pressing OK. The Bridgemate will now display the verification screen.

The Bridgemate will not display an overview for unplayed boards, since it is possible to play the board in a later
round. The board can be played afterwards without the Bridgemate; in that case, the relevant score is entered
manually into the scoring program. BOUND 1 W5l EMaE  Ei-ay

When rules in your club say that players are not allowed to skip a board without notifying the EEEFQEQPQDQELﬂth

director, the Bridgemate Settings (see chapter 6) should enable the option “No Play requires TD PIN:
TD confirmation.” The Bridgemate will show the following screen:

[ ERCH]
The director enters the PIN code to confirm the “no play.” This prevents players from entering ss
a no play when they are not authorized to do so. En?ugags
. 5395 Ed632
View hand record QROESE oveme AUINISE
If a hand record has been preloaded for this board, or entered by players in a previous round, 074
| ESCH BT

the hand record can be viewed by the players to verify if the correct board was played and/or
the cards in each hand are correct. Press the HANDS button in the overview of previous results to show the hand.

General comments:
e The Bridgemate monitors the active rounds. In case of a sit-out, the Bridgemate will skip the round.
e Before starting a new round, verify whether you and your opponents are seated in the correct direction to avoid
playing in the wrong direction. At the start of the round, press OK to display the directions.
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Ranking and Game Summary orking s o s

The Ranking feature must be checked in order for the end-of-session results Ranking:
(shown as percent for each board — or — match points won) to be available. Note, | Show ranking at end of session only =l
with the ranking feature, information may be displayed after each round, or only at Don't show ranking

Show ranking after each round
the end of the game. . 2

“ ” i VIEW RANKING B
END OF SESSION e A o o 1 At thg.end ofa game, press Re‘l‘nk to display th(?’ AN
m PROVISIONAL RANKING: Provisional Ranking; then click “Game Summary” to and direction to
SIDGEBTE 1o Ns: 1. 70% | display each board’s Match Points or Percentage. view ranking
o - After the game, log on as any table; press PAIR: 5 NS
BACK RANK T SCORES — g 9 y P

the “Rank” key and enter your pair number.

Note: When viewing game results at your last table, press the E/W or N/S button to view E/W or N/S results.

Reviewing scores and rectifying scores

Reviewing scores entered
After a board result has been entered and confirmed, players  COHTFE :

BN M BHA2  BLB) ™ CORE RECAP — BOARDS 21-24
BOARD -

21:4H N 6 680

22:3NTxW 3 750

may want to review what has been entered. The Bridgemate |LEAD : . _

X X . 23:2C S -1 100
allows the players to review their own scores at any time RESULT:
during the round and at end of round. To facilitate this DO BT

function, enable the option “Score recap” in Bridgemate settings (Chapter 6). Press SCORES to show the recap.

The entered board results — Including the score points — are shown in board-number order. If more than four boards
are played in the round, up and down function keys are visible for navigating through the results. To exit the score
recap screen press the BACK function key.

Rectifying an input error

If you have made an input error while the board result has not been confirmed yet by E/W, press CANCEL to rectify
the error. In principle, it is possible to return to the board number input row by repeatedly pressing this button. Itis
also possible for E/W to reject the entered data by pressing CANCEL. The Bridgemate will now return to the input
screen, and the entered data can be deleted by pressing CANCEL again.

Once E/W has confirmed the score and the message “Entry completed” has been displayed, the score can only be
edited in the following two ways:

e 1. By the director using the special director's menu (TD-menu). See the section “TD-menu” below.

e 2. By the players themselves through the score recap screen. When “Allow players to erase scores” is
enabled by the Bridgemate Settings (see Chapter 6), the score recap screen will show the CORREC function
key. Press this function key, and — when asked for the board number to correct — enter the board number
followed by OK. The result is now erased and can be entered again by the players.

Posting Bridgemate Il scores

Results to Bridgemate Control Software
Information entered on the Bridgemates is first saved on the server. The BCS program continuously reads the data
from the server and stores these in the result (.bws) file.

Posting scores in the scoring program
Once the scores have been saved in the result (.bws) file, your scoring program can post the scores. For more
information, please consult the manual of your scoring program.

Reviewing and amending names e
Reviewing and rectifying names during a round COMTR a
When players enter their numbers into the Bridgemates (or names have been transferred LEAD

from the scoring program) the names of the players expected to be at a table may be viewed %T:

by pressing the NAMES key.

Players can amend their player number during a round. Press the NAMES key and then Eéggﬁilmggggn

Ha
CORREC key. One-or-more player numbers can be edited; they are then updated and can E Keuin Edwards
Iz

be confirmed. Mary Erooks
Pres=s CORREEC to
chanae plagers

- EEREE——— [
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Reviewing and amending names during each round.

In events where the composition of the pairs (or teams) can vary from round to round, the Bridgemate can be
configured to request confirmation of the player names at the beginning of each round. To this end, the names of
the four-expected players will display on the Bridgemate; if the composition has changed, players can easily amend
one-or-more name by pressing the CANCEL key to update the player number(s). This feature is of most benefit in

team games, where the actual player in every round of the team may be relevant. T E—
. BOARD : _

Calling the TD EEHTR :
Bridgemate contains functionality to call the tournament director with a simple button click. BESILT :
When this feature is enabled, the soft key CALL TD is available in the score entry screen. e TS
: Y By clicking this button and confirming the TD call, a signal is sent to the
0 calls = director. The TD is notified by BCS; if the sound is turned up there will

CallsE . . .

be an audible “knocking” sound. Position the cursor (as shown), press-
Section | Table | Round | Time log hold the left mouse button and move it up to enlarge the TD call area.
G 3 7 12:51:41 PH The Bridgemate Pager system is a convenient way to selectively notify

directors of a call. More detail is on the www.bridgemate.us website.
The Bridgemate App may be used to notify directors out in the room.

TD m en u ROUND 1 HE1l EWE1R 21-24
Tournament directors have far-reaching powers to verify and edit entered scores and to award TD PIN: _
adjusted scores. A special TD menu is available for this purpose. This menu is accessed with a

4-digit PIN code set in BCS’s Bridgemate Il settings. The default PIN code is 0000. Users often ===

change the PIN code — since the default “0000” will be known by many people..
Activating the menu

To access the TD menu, press the TDMENU function key whenever it is visible. The Bridgemate will ask for the TD
PIN code. Enter the 4 digit PIN code. The TD-menu will now appeatr.

TD-MEHLU TO-HEHLU

[ Adjusted zoore B, Soore recae The TD-menu consists of two pages. Use ki & E¥ to

2. View results 7. Hand records navigate between pages. To exit the menu, press BACK.

3. Erase result 8. Reset

g. ﬁ?:;lﬁg N -+ Adjust contrast To retransmit all results to the server, press the RESEND key;
T e —— e You must first the “Backup scores” options: See Page 33.

Menu options

The TD-Menu has nine options:

1. Adjusted score To enter an arbitral (adjusted) score. Note: the cursor must be on Contr: ki

2. View results For an overview of the entered scores.

3. Erase result To delete an entry.

4. Status If you would like to view the current table, section, round and pairs.

5. Missing boards To retrieve an overview of the board numbers not yet entered.

6. Score recap Display current-round results. Useful when the “Score recap” option is not checked.
7. Hand records Use to View, Enter or Erase hand record(s).

0. Reset To reset the Bridgemate.

-+ Adjust contrast To change the contrast of the screen, press + or -.

All options are available from both pages by pressing the corresponding key. There is no need to move to the page
which lists the options in order to use them.

Entering an arbitral score TO-MENU - ADJUSTED SCORE
It is possible to specify in the Bridgemate that an adjusted score must be entered HSE -

for a certain board. With the cursor is positioned at CONTR, access the TD-menu ~ EM?

by pressing the TDMENU function key, enter the PIN code, and once in the TD-

menu, press ‘1’. The following screen appears: BRCE |

Enter the arbitral score for both pairs. You can choose between 40% (average-minus), 50% (average) and 60%
(average-plus). Press 4 or — key to enter 40%, 5 or = key to enter 50%, 6 or + key to enter 60%. It is not possible to
enter a value other than these percentages. Press OK after entering both percentages. The Bridgemate will now


http://www.bridgemate.us/product/pager/

Chapter 5: Use of the Bridgemate® Il scoring devices 27

return to the result entry screen with the assigned arbitral score displayed at CONTR. Press OK to confirm this, and
confirm the verification screen. The Bridgemate system has now saved an arbitral score for this board.

Retrieving overview

To obtain a overview of the results that have been entered on a specifc board on this table, use the view results
function of the TD menu - ‘2.". You will be asked to enter the board number. The overview displays the pair number,
direction of play, contract and result. The number of score points is not displayed. If the screen returns to the TD
menu after the board number has been entered, no results have been registered for this board at this table. Note
that results that have been entered on the same board but in other Bridgemates will not be shown in this overview.

Erasing entry
Directors always have the option to erase a board result from the current round or any previous round.

To erase a board input, press ‘3’ in the TD-menu. The screen will display “BOARD:” — awaiting input of the board to
be erased. Enter the board nhumber and confirm with OK.
e If the board to be erased has only been played once before at this table, it will be erased immediately —
regardless of which round it was originally played in.
¢ If the board was played more than once at this table (e.g., Howell movements), There will be a prompt asking
for the round number.
If the particular board can be erased, the message “Board erased” will be displayed to indicate that the entered result
has been erased. If the board has not yet been played at this table, the Bridgemate will return a message saying that
no results could be found for that board number.

Once a board result has been erased, the correct information may be entered.

Note when using the ACBLscore: Board results may be erased at the Bridgemate; however, the correction will not
be transferred to ACBLscore if the result has already been posted into ACBLscore. Once a board has been posted

into ACBLscore, the correction must also be made in ACBLscore. — JUEKIEHI F-|1 ESIIAIIGE
= =1
Retrieving current status Round: 1
. . . FPairs: 1-12
If you no longer know to which table and section the Bridgemate relates, you can Boards: 21-24

retrieve this information in the status part of the TD menu. Press ‘4’ to retrieve the
status. The expected table and section of the Bridgemate will be displayed first, =
followed by the current round, corresponding pairs at the table and the boards to be played in this round.

Overview of missing scores

From the TD menu, it is easy to establish which boards of the round have not yet been entered. Press ‘5. The
Bridgemate will now display the numbers of the boards not yet entered in this round at this table.

Resetting the Bridgemate

The Bridgemate can be reset from the TD menu. Press ‘10’ and OK when prompted to confirm ‘Reset Bridgemate?'.
It will now return to the main screen.

Score recap
The scores recorded in the Bridgemate for the current round may be viewed. This may be helpful to verify results
entered when the ability for players to see the scores themselves has been turned off in the Options settings.

TO-MEWI - HAWD RECORDS ENTER HAND RECORDS
1. Miew hand record

Hand records

2. Enter hand record BOARD:
View, enter or erase 3. Erase hand record When entering a board
hand records from this confirms the boards | VALID BOARD NUMBERS:
. . 3-4,6-10,12-27
any Bridgemate. FERCH | still to be entered.

BACK

Setting contrast
Screen contrast may be adjusted from the TD menu. Press + (plus) to make the screen darker or — (minus) to make
the screen lighter. Press the button several times to adjust the contrast. It is also possible to adjust the contrast by
going to the Setup menu (from the Bridgemate Il main screen), see Chapter 5, Configuring the Bridgemate.

Retransmitting all scores

Each score entered is stored in the Bridgemate’s internal memory. When one or more scores have been entered,
the TD-Menu will show the RESEND function key (above the NT button). This allows the TD to retransmit all scores
to the server. For more information about its usage, see Chapter 7, “Resending Results.”
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tions - Bridgemate

Bicgemate | Brdgemate i |

Bridgemate settings  Tools = Options = Bridgemate DR ——

Settings specified by BCS or scoring program
Settings can be specified either by the scoring progr.
scoring program — choose “Scoring program. eck your pro
settings for Bridgemate options. Use “Bridgemate Control” "when you
want this BCS screen to control the Bridgemate settings disregarding
the information provided by the scoring program.

" Symbols
' Charachers

Dptonal eriry
& Lead cad
I~ Validatn lead cavd againgt hand record

Settings

Displaying previous results overview and percentage

To enable the Bridgemate to display an overview of previous board
results, check the “Show previous results” option. To display your own
score in this overview, check the “Show own result” option. Your own score is indicated by a - (6 lin
lines). Limit the number of scores to be displayed by entering a maximum number. “Unlimited” remoyes the
limitation. Boards may also be displayed as “Traveller” — one line for each result

To display the board result percentage achieved so far, check the “Show percentage of own result” bok.

When multiple sections are calculated as one, check the option “Group sections for results.” The percg¢ntage will be
calculated across the field, and the results on all boards with the same number are shown in the previous results
overview. Especially in this case, it is recommended to set a maximum number of scores you want the|Bridgemate
to show. Without doing so, the players will use up a greater amount of time reviewing the results at large sessions.

Results overview Results can be shown 6 different ways: See examples on Page 24, 2how previous results
Special Note: The “2-score columns” also controls all Bridgemate results displays. |Freauency ist, §ines. 2 scare columns v

Perspective of score points

Score points — on the East/West Verification screen — can be displayed from the perspective of the declarer or from
the N/S direction of play. In the latter case, E/W score points are shown as an opposite score (4H making 5 by E/W
is displayed as -450 or -650). This applies to the score points displayed in the verification screen for E/W and the
score recap. The overview of previous board results always shows the scores as 1 or 2 columns — N/S best to worst.

Entering results Results can be entered in three ways: as overtricks / downtricks, as the total number of tricks
won, or American style (tricks made/down). This should be “American Style” in North America with ACBLscore.

Displaying the pair number If you do not wish to display the pair numbers in the round-information screen,
disable the “Show pair numbers at round info” function. This option can be used for team-of-four events.

Transmitting contracts

The Bridgemate offers users the option of feeding information to the server immediately after the contract and/or lead
card have been entered. This could for example be displayed on vugraph presentations while the game is still being
played. If you wish to feed this information to the server, check the “Intermediate transmission of contract” box.

Board order verification Check if you would like the Bridgemate to verify that the boards are played in the
logical order. An error message will appear on the Bridgemate if the entered board number is not in logical order.

Lead card If you would like to enter the lead card on the Bridgemate, check this setting. To control the correct
lead-card entry check the “Validate lead card against hand record” setting — if hand records are available in BCS.
Note: Lead card validation occurs only when the ACCEPT key is pressed.

Member numbers If you would like to enter the member numbers on the Bridgemate, check this setting. By
default, players have the option of leaving the entry blank when entering the member number. If entry of member
numbers is compulsory, check the “Blank entry not allowed” box. This should normally be unchecked.

Validate member number When checked, you may specify ACBL member numbers are to be validated.
View contract Use this function to specify whether card symbols or letters to display the contract.

Auto power-off periods

The Bridgemate will automatically go into auto power-off mode if it remains idle for a while. The default setting is 20
seconds. To change this setting, enter a value between 5 and 60 seconds in “Autopower-off period.” “Verification
message,” is the length of time the “Verification by East or West” is displayed — normally this should be 1 second.
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More Bridgemate settings (on Bridgemate 1l tab)
TD PIN code Set the 4-digit PIN code to access the TD-menu.

. . i Biricl te 1
TD confirmation for No Play Biidgemate  Eiidgemate

Check the “No Play requires TD confirmation” box if Pair number entry az part of declarer Optionz for tournament director

13 i (;\I -
players must call the TD for “No play” approval. ~ %stz:: oty BIN code: |0000
Show remaining boards to be played " Enlry required ¥ Mo play' requires TD confirmation
Enable this option to show the number of remaining Player names ' oy TO calls from Bridoemate
boards in the current round after E/W verification. O Dont shownames

Dizplay additional infarmation

Show Seatinqs for next round (+ Shaw names at each raund [v Bemaining number of boards to be played

" Show names at first round anly

[v¥ Mext ssatings at end of round

With the “Next seatings at end of round” option, the Settings ¥ Soore reoap
Bridgemate shows which table pairs should go to and W Show score recap automaticaly
the direction to sit; to stay in their current position; or Rianking and game summary [ Allow players to erase scores
that they will have a bye. fakins: ,

. |Sh0w rarking at end of session only j v futomatic _en"-'" of b.oald number
Show score recap and allow score corrections _ [ Enter first board in round manually
To allow the players to retrieve a score recap of their = ihw SOUED el °:fe“'°” _ ¥ Enable RESET function key
own scores entered in the current round without the Percentage  Matchpents Hcssrdta gz
TD's assistance, check the “Score recap” box. Hand records [ Record bidding
However, normally players are expected to call a B et B eeee play
Director when a score needs to be corrected; thus, do | ¥ Erterhandreserds =

{* End of round " End of board r~

not check the box “Allow players to erase scores.”

Show score recap automatically
When this option is checked, the Bridgemate will automatically display the scores for all boards played in the round
just completed at this table. It does not show the results of these boards at any other table.

Automatic entry of board number

If you want the Bridgemate to automatically fill in the board number and players only to confirm the number with OK,
enable this option. If board sharing takes place frequently and the order of boards played deviates from the logical
order, it is advised to disable this function. Alternatively, you may wish to check “Enter first board in round manually.’

Enter first board in round manually
When boards are shared between tables and for team games where boards are shared, this option will expect the
players to enter the first board they are playing; thereafter, the next board will automatically be entered.

Enable RESET function key

Pressing the TDMENU key will display RESET on Bridgemates Il for player access. At times, it can be helpful to
instruct players to reset their Bridgemate[s]. This does not cause any problem since the Bridgemate will
automatically return to the same screen when it is restarted. This should normally be checked!

Recording of bidding and play

Bridgemate has a built-in capability to record and bidding and play. This feature is generally only used at large,
international tournaments where live coverage of the game or full recording for statistical or review purposes is done.
Refer to the Bridgemate Developer’'s Guide for more information on this topic.

Pair number entry as part of declarer

The declarer on a board is normally indicated by direction only. As an additional verification of a possible pair arrow
switch (not uncommon in Howell games where pairs switch direction), the pair number may be entered as part of the
declarer. Players will be warned when the combination of pair number and direction input is not valid.

Link. member numbers and names uzing source:

Showing player names

In order to promote correct seating of players, Bridgemates can show the player - Bridgemate soore fle. iequies that names are nadd i
names at the start of the round. By reviewing the names, players understand if e bus e by he seing prog.

they have taken their correct positions. C e e laated nhe o dndbase o
Configure name settings i s s o Bt "
Check “Show names at each round” or “Show names at first round only.” Next - T i o GBI
click “Settings” to configure which source BCS should use to find the player " lookup database fe

names. Clubs/Units with a local player database will check the 1% option; when B s sl szl el e s

using a Tournament database, check the 2m option. TD’s that direct Club/Unit
games as well as tournaments may check the 4" option; thus player names will automatically be found in either th
“local” or the "national’ database. The 5" option is for databases that have player numbers with leading zero’s.
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Sit-out Pair Names Display See Chapter 8 — Names Display for 1 Round Sit-out Pairs.

Showing names using member numbers

Member number entry at the start of a session is mandatory in order to identify the players. Make sure that member
number entry is enabled (in the scoring program or Bridgemate options). BCS uses the member number to find the
player name. This requires that the correct source for the player names has been selected, either Bridgemate score
file, BMPlayerDB.mdb lookup database file, or “both” (4th option above) and that the source contains the names. If
the wrong source is selected, or the source does not contain any names, BCS will not find nor display player name.

Once BCS has found the player number, it will show the name and number in the “Players” tab, and show the name
on the Bridgemate. Special procedures are required in order to display the names of the pair with the first “sit out.”
See Chapter 8, Phantom-table sit-out pairs, for more information.

Changing names

In addition to the ability to make corrections on the Bridgemate (see “Review player names” on page 22), corrections
and additions can be made in BCS from the Players tab. Double-click in the “Name” column at a table/direction and

enter or modify a name; the new name will automatically display on the Bridgemates Il. Alternatively, double-click on
the member number and provide a new or correct number. BCS will display the name for the new/corrected number.

Using Profiles to store and retrieve Bridgemate option settings.

With Bridgemate Control checked, both the “basic” Bridgemate and Bridgemate

Il settings can be saved to a “Settings profile.” For different types of games, = 5

different profiles can easily be retrieved by selecting a profile from the |

dropdown list on the left side of the Bridgemate settings window. === |¢

Note: The USB Server must be attached (and “connected”) in order for
profiles to be active and editable.

Creating, updating and deleting profiles

To create a new profile, set the Bridgemate settings based on your preferences
and then click on Save as new profile. Enter a name for this profile and press
OK to save the profile with the selected settings.

To modify an existing profile, first select a profile from the dropdown list, modify one or more settings and press
Update profile. The profile is now updated with the latest settings.

To delete a profile, select first a profile from the dropdown list and then press Delete profile. The profile is now
deleted. The last remaining profile cannot be deleted.

Apply a profile

To apply settings from a profile, select the profile from the dropdown list to update the Bridgemate settings based on
this selected profile. Next press OK to close the window and store these settings as current Bridgemate settings.
Note: Using OK also “updates” the current profile.

Using a profile when starting the Bridgemate system
If your scoring program (such as ACBLscore) does not support all Bridgemate options, and you want to set the
options when BCS is being started: this can be set within BCS:

1. Goto Tools 2 Options 2 General, and select tab General.
2. Enable Show Bridgemate options when starting new session and press OK to save this setting.
3. Close BCS and start Bridgemate from your scoring program.

Every time the Bridgemate system is started by the scoring program, the options window will appear automatically. A
different profile may be selected or changes can be made to the Bridgemate settings. Press OK to confirm the
settings. The Bridgemate system will now start with the selected settings.

Hand Records See the www.bridgemate.us/how-to-guides/hand-records/ for more detail.

ENTER HAND RECORD ENTER HAND RECORD ENTER HAND RECORD—BOARD 7

Boards that have been shuffled and dealt at the table may ENTER e e
be recorded by the players. Hand records are entered on ENTER VALID BOARD NUNBERS S: AK65
HAND RECORD? 7-8 ; 10943

H
D: QJ82
RACKI c- 9



http://www.bridgemate.us/how-to-guides/hand-records/
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the Bridgemate — after each board is played or at the end of a round. It is not compulsory, so slow playing tables can
move on to the next round; subsequent table(s) can then enter the hands. Also, the Director can enter hand records
using the TD Menu. North, East and South cards are entered; the remaining cards will

automatically display for West. [Server T

Show tables
If the “View hand records” option is checked, players may view a hand on their Bridgemate after Show all scores

playing the board. The Director may use the TD MENU (from any Bridgemate) to display any hand Show hand records
record — regardless of the “View” option setting. Also, hand records may be viewed in BCS. —»

Hand records entered on the Bridgemates (or imported from a .dup, .pbn or Big Deal .csv file) are stored in the result
(.bws) file. There is a more detailed description “Hand Records and Makeable Contracts” on the Bridgemate flash
drive and on our website Www.bridgemate.us/how-to-guides/hand-records/

Use File = Import - from .DUP, .PBN or .CSV to enable displaying hand records at the table. Directors will be able
to review the hand records using TDMENU. Also, when enabled, players will be able to view hands.

Analysis of Makeable Contracts (Double-dummy Analysis) R sever took
BCS has integrated makeable contract analysis based on Bo Haglund’s Double Dummy Solver. aitmovement
Makeable contract information is stored in the result (.bws) file; it can be printed or exported together S —

Update movement

with the hand records. To control the analysis feature go through Session - Report sessign. Then, Close rounds
click on the “Hand record analysis” tab and check “Automatic analysis of hand record durin}p@\ Upload hand recorc

Hand records will be analyzed as each board record is entered. Similarly, when a hand-record file is O
imported, BCS will automatically analyze the hands even if the file being imported already includes Report session
makeable contracts because many programs do not fully analyze the hands. SRR

Printing, Exporting and Importing Hand Records
Use File = Print — to print hand records (with or without analysis) direct to a printer — or — export and save in one of
several formats.

Use File &> Export to export hand records to a file. If there has been a BCS analysis of the hand records, the .pbn
file will include makeable contracts.

Use File = Import to import hand records into BCS. BCS will normally analyze the hands to improve accuracy for
Suspicious Contracts review.

Update settings during play

Option settings are sent to the Bridgemates when a new session is started and Bridgemates log in to the server. Itis
also possible to modify the Bridgemate Il settings during play and have the Bridgemates use these new settings.

To update the Bridgemate Il settings after the Bridgemates have already started the session, do the following:
1. Update the Bridgemate settings either through the Bridgemate and Bridgemate Il settings tabs in BCS (Tools
—> Options) or in ACBLscore (F11 - BMO).
2. Goto menu Server - Show Tables.
3. Select the tables for which you wish to update the settings. Note, CTRL + A will select all the tables at once.
4. Press the “Update settings” button. The selected Bridgemates Il will now receive the modified settings.
Note: The “Group settings” setting cannot be updated during a game. BCS always uses the initial game
setting from an F11 = BMS start.

Updating Bridgemate firmware see Update instructions on www.bridgemate.us

e Bridgemate® Control Software -

Server  Tools Help

Real-time Publication
During a game the rankings may be continuously displayed. The
display will start after a few seconds (it opens your browser —

Internet Explorer, Firefox, etc.). As each new score is received,
the display will automatically update to show the latest rankings.

Report Session

Edit: movement

Synchronize | recover

Update movement

Close rounds |v Enable Live Ranking
Upload hand records

) [v Shaw number of boards
Run Bridgemate Pro concurres

[v Show percentages
Report Session


http://www.bridgemate.us/how-to-guides/hand-records/
http://www.bridgemate.us/
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Bridgemate logged on as the wrong table PROCEED S AL?

When a Bridgemate logs on under a wrong section or table number, this will affect the

Bridgemate of the other table whose section and table number has now been occupied. Press ERASE to erase

11 i data.
To rectify this situation, the Bridgemate Il has a simple “take over table” procedure. Just let aPre_'s);e&ﬁ#;N.aTz_
the Bridgemate of the correct section/table start the session. It will show that the table was B

already started by another Bridgemate and asks to proceed or to cancel. Press OK to
proceed, and call the TD to confirm the take-over using the TD PIN code. The TD should
press the “Erase” button to remove the player numbers and any scores entered by the errant table. The correct table
may now enter their player numbers and start playing. After confirmation, the table will start the session.

The wrongly-logged-on table will now see a message that another table has taken over. They may mE
now log on as their correct table, enter their player numbers and any results. TAKEN OVER

Replacing Bridgemate

If for whatever reason you need to replace a Bridgemate during a session, and you are unable to log off the
Bridgemate using its reset function, proceed as follows:
o Remove the Bridgemate to be replaced.
e Take another Bridgemate and set it to the Section/table where you wish to place it in service.
o It will inform you that the table has been started by another Bridgemate: Press OK to proceed, enter the TD
PIN code, press CONTIN. This Bridgemate has now replaced the unit that was “taken out of service.”

Alternatively:
e In BCS, go to menu Server - Show tables.
e Select the relevant table and press “Log off table[s]”. The Bridgemate will now be logged off from the server.
e Take another Bridgemate and set this Bridgemate to the correct section and table number. Also make sure to
set the correct channel.
e Activate this Bridgemate. The Bridgemate will take over the position of the old Bridgemate.

Recovering the server

If the server is accidentally disconnected from the PC — and there is no battery power — all data will be lost and the
Bridgemates will stop functioning. Bridgemates will typically display “FAILED TO SEND, RETRY?” BCS,however, is
able to recover the old situation. Proceed as follows:

- Make sure the server is reconnected the PC and that BCS shows the server is “Connected.”

- In BCS, go to menu Session - Synchronize / recover.

- Go to the “Recovery” tab and press “Recover server” and follow the screen prompts — including entering the 3-

digit number (when prompted). All information from the result (.bws) file will now be moved into the server.

When recovering the server, it is important that all data had already been read from the server into the result (.bws)

——ww woa | file. Ifthis is not the case, information that had not been recorded so far will not be recovered
% Crijéxs:zguﬁgre back into the server. HARDWARE: 1.0
i- E{Zﬁﬁsresu't It shoulq also be noted that results may be resent t_o _the server. :égg‘%ﬁ;_ ;6(1)6}11
5. Missing boards During a game: After a game has finished ’ :
On the TD-MENU page and before the next game is started, go
press the RESEND key to SETUP - INFO press the RESEND key.

Note: For more info on resending results — see Resending results on page 33.

Procedure in the event of data loss

The security of the board results entered in the Bridgemate Il scoring system is given top priority. The best defense
against data loss is that results are stored in multiple locations, namely:

e The Bridgemate memory
All results entered in the Bridgemate are sent to the server. At the same time, each result is also stored in the
Bridgemate’s internal memory. These results are stored until the Bridgemate is logged on for a new session
and the first result (of the new session) is “accepted.” Then the memory (of the prior session) will be erased.

The data remains stored in the Bridgemate, even if no batteries are installed. See “Resending results” — on the
next page — on retrieving results from the Bridgemate’s memory — direct — to the results (.bws) file.
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e The server memory
Results entered in the Bridgemate are sent to the server, and stored in the server’s internal memory. Itis
essential that the server has batteries installed — so it can switch to battery power if the PC power is lost. If
there is no power source all data will be lost. It should be noted that the server will stay active on battery
power alone for an hour after its last action, e.g., the last result is sent from a Bridgemate.

e BCS result (.bws) file and loqg file
BCS continuously reads the new results from the server and processes these into the result (.bws) file. This
data is immediately written to the hard disk of your PC, ensuring the data is safe — even in the event of power
failure. All results shown on the BCS screen have been written into the result (.bws) file.
BCS also has a log file, containing all the relevant events. All received results are written to this log file. To
view the log file, go to the Tools = Show log file menu. The actual file — BMProLog.log — is located in the
folder specified under the Tools = Options - General - File locations Tab.
Special Note for Vista, Windows 7, 8/8.1 & 10 Users: See Log file settings, Chapter 3, for details.

e Session file in your scoring program
Lastly, the scoring program retrieves the results from the result (.bws) file and stores the results in its own files.

The results are therefore stored in five locations in total. In the event of data loss in one of the five locations, it is
possible to check whether the results are still stored at the next level up, and to reprocess the results from there.
Scoring program data loss

In the event of scoring program data loss, check if the results are still stored in the result (.bws) file. The recom-
mended method is to launch BCS from the Windows Start = All Programs - Bridgemate Pro - BCS. Once BCS
starts, go to the File 2Open menu and select the result (.bws) file for the session. If the results appear on the screen,
they have been stored in the result (.bws) file. The results can now be reprocessed from the scoring program.

BCS data loss

If the result (.bws) file contains no (or incomplete) results, it is possible to retrieve them from the server and to read
them in the result (.bws) file. The first step is to check whether the results are still stored on the server. Use the
Server > Show all scores menu for this purpose. All the results stored in the server will now be shown. If the correct
results are shown, it is possible to read them manually using the Server = Show tables menu. Select all tables (Ctl-
A is a shortcut to select all the tables) and press “Retrieve scores”. The results of the selected tables are retrieved
from the server and processed in the result (.bws) file. The results can now be read by the scoring program.

Server data loss

If neither the server, nor the result (.bws) file, nor the scoring program contains any data, your last resort is to retrieve
the results from the Bridgemates. All results entered in the Bridgemate are stored in the internal memory of the
Bridgemate and can be resent to the server. See the section above entitled “Recovering the Server.”

Warning

The board results are stored in the internal memory of the Bridgemate. Once the Bridgemate has been started up
again for a new session — and the first result for the new “game” is entered/confirmed — the memory is erased and all
the previous game’s data is removed.

Retrieving results from the log file

Results can also be retrieved from the log file. All results entered in BCS are stored in the log file. To view the log
file, go to the Tools - Show log file menu. The selected rows can be copied and saved to an empty text file and
printed. Automatic processing is not possible; the results must be entered manually in the scoring program. The
actual file, BMProLog.log, is located in the BCS folder, normally C:\Program files\Bridgemate Pro.

Special Note-Vista, Windows 7, 8 & 10 Users: Because of Windows’ “security precautions,” use the BCS option to
specify a non-Program Files folder where the Log File should be saved. See Log file settings, Chapter 3, for details.

Resending results

The Bridgemate retains the board results in its internal memory — until a new game is started and a new board is
entered. With a simple command, these results can be resent to the results (.bws) file. This is useful when results
have been lost from both the computer and server inadvertently and your last resort is the Bridgemate device itself.

Results can be resent from both the TD-menu and the setup menu. Proceed as follows:

1. Make sure the server is connected and loaded with the session data (tables, movements). If the server data
was lost as well, restart BCS from ACBLscore (F11 = BMS); this loads the session data into the server.

2. With Fesults o Result matriz selected, click on “Backup scores™{(tab) below and e, | sut | suspeios coracts Bockigscors |
enable the option~If this is not checked, BCS will ignore the retransmitted
backup results. This must be checked each time results are to be resent. ¥ hoept manuall e sent backup scores o Bridgsmate

3. a) Bridgemates, still in result-entry mode, can resend the results from the TD- W Restore backup scores automaticall to server
menu. Press the TDMENU function key and PIN code — then select RESEND.
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b) Bridgemates, which show the main screen, can resend the results from the setup menu. Press SETUP
and the 749 or 769 Setup code; on the Setup menu; press the INFO key, followed by RESEND function key.

Note: Be sure the Tools > Options > General option | Clase program at end of session js ynchecked.

4. The Section/table and number of results in the Bridgemate’s memory will display. Press OK to start the re-
transmission. Retransmission will only succeed when the server is activate and contains the session data.

5. Starting with Bridgemate firmware 2.2.2, units return to the main screen when the device goes into standby.

Multiple bridge clubs playing simultaneously

There may be times when 2 or more bridge clubs are playing at the same time in one building — each with their own
client PC. As the Bridgemate server can accommodate only one specific client computer at a time, it is not possible
for two clubs to make use of one server simultaneously. Both bridge clubs will, therefore, require their own server.

It is, of course, vitally important that they do not interfere with each other. This problem can be rectified by:

e each club using different Section letters. In this case the clubs can use the same channel.

e the systems communicating over different channels. The first club sets its system (server and Bridgemates)
to channel O, while the other uses channel 1. A third and fourth club can then use channel 2, 3, etc. This
method enables multiple clubs to use the Bridgemate scoring system in the same area simultaneously with
the same Section letters without causing any interference.

Large tournaments

During large tournaments, more than one server will be required to control over 256 tables. The layout of the tables
is important in this respect. If the tables are outside the range of the server, an extra server will be needed to
increase the range. The Bridgemate Scoring System supports multiple servers over a network. In principle, this
network can support an unlimited number of tables. The following guidelines must be observed:

e You will need a fully operational network in which all used PCs are interconnected, enabling them to access
and process files.

e Only one result (.bws) file is used, containing all session data and board results of all tables.

e The scoring program is running on one of the computers in the network. It is not necessary for the scoring
program to be running and/or the result (.bws) file to be stored on one of the client computers that is running
BCS. From an organizational point of view, it may be easier to use a separate PC containing the scoring
program and .bws file. Client PCs access the .bws file over the network.

e Each Bridgemate server is connected to its own PC (=client) where BCS is running. Do not connect two
servers to one client PC; although technically feasible, it may cause unnecessary confusion, as both servers
are using the same client name. Worse still, it may even be counter-productive if both servers are operating
over the same channel.

e Use different channels for each server, especially if the servers are within range of each other. Only use the
same channel if you are sure that the servers are not interfering with each other (e.g., in different buildings).

Using ACBLscore and Bridgemates on a Network

ACBLscore and the Bridgemate Scoring System can be used on a network where the ACBLscore program and
Bridgemate Control Software (BCS) software both operate on one computer. Each separate client computer will run
its own BCS program and open the single result (.bws) file, e.g., 070904E.bws, on the ACBLscore computer.

ACBLscore Computer

- Configure the C:\ACBLSCOR\GAMEFILE folder for Network sharing and “change my files” by a remote computer.
- In BCS, Server - Show Tables, highlight tables controlled on the remote computer[s] and click Delete Table[s].

- The BCS option (Tools - Options > General) “Mode = Club [single computer]” should be checked.

Remote Computer[s]

- Open BCS program and check the BCS option “Mode = Club [single computer]” (Tools - Options > General).
- Use File &> Open to manually open the *.bws file on the ACBLscore computer.

- BCS lower left: Highlight tables to add to this client - right click and click Add to client

Note: The tables not “added” above, will not be in this “remote” server.

If the Bridgemates working into the Remote Computer[s]’ server[s] are configured for different channels, the BCS
changes need only be made at the Remote Computer|s].

Contact Bridgemate.US for more detail.
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Chapter 8: Using Bridgemates Il with ACBLscore

ACBLscore (Windows), starting with version 7.45, supports the Bridgemate Scoring System. This chapter describes
how to use ACBLscore to activate Bridgemate Control Software (BCS) and retrieve information from the result (.bws)
file.

Installation

Software Required
e ACBLscore (Windows version) v8.33 or later — download from www.acbl.org
¢ Bridgemate Control Software install program — on website www.bridgemate.us or Flash Drive.

Install software

The BCS program controls communication with the Bridgemate Il hardware and exchanging data with ACBLscore
through the result (.bws) file. The default installation folder is C:\Program Files\Bridgemate Pro (32-bit PC’s) or
C:\Program files(x86)\Bridgemate Pro (64-bit). BCSsetup.exe installs BCS and the USB driver. It is recommended
you accept the default installation folder.

Special Note for Vista, Windows 7, 8/8.1 & 10 Users: Because of Windows' “security precautions,” BCS log files
are saved in each Windows® User’'s Appdata folder. See File locations on Page 17, Chapter 3, for details

Install ACBLscore Version 8.33 or later.

Note: Normally, BCS and ACBLscore will be installed on the same “client” PC.

Connect the Bridgemate Server to the Computer.

The server uses a standard USB cable. Windows should recognize the new device and provide screens to install the
driver. The Server receives power from your computer's USB port. The 4 AA batteries should always be installed
to provide “backup” power if there is any PC power problem. This will preclude inadvertent loss of scoring data.

BCS Setup o
Server information | Value
Verify BCS/server connectivity Bripemale server  Lornected
) L wstem Bridgemate Il
Once the server has been activated, start BCS to see if it finds the server. Normally, BCS  Fat _
is started by ACBLscore; but to verify server connectivity, it is recommended BCS be pardware verson 10
started directly from the Windows start menu at this time. Commurication version 1.1
Battery lewvel 100%
The BCS screen should show “Connected” in the upper left “Server Information” section. phanne N .
egion Marth America
Set BCS options
General IV\EW 1 File: Incalinns] Scoring pmglam}
Go to menu Tools - Options > General ot s conpue Ei‘"’“g@;mm@@lg

“C|Ub (Slngle Computer)” " Toumament network] ¥ Erase oniginal records of deleted scores
“Disable server detection” (unchecked) P T ShowBikgenst spons when stainan
“Erase original records of deleted scores” MUST be checked when using_dAQBLscore
ndgemale server
1 1 1 [~ Disable server detection
See Chapter 3, Program SEttlngs (Optlons), page 16 for Optlon [Does not disable server detection at startup]
settings on the General, View, File locations and Scoring program tabs.
Bridgemate ||
Go to Tools = Options = Bridgemate Avcpoweroftpeiod:  [Thor <]

Options should be set as appropriate.
See the laminated Quick Setup Guide and Chapter 6, Bridgemate settings, page 28.
For installations on replacement PC’s, see www.bridgemate.us/media/downloads/quick-setup-guide.pdf

Configure Bridgemates
1. Use SETUP to configure each Bridgemate.
2. Each Bridgemate may be:
- assigned to its own Section and Table: Al, A2, A3 .....,, B1, B2 ...., etc.
- configured for manual entry of the Section/Table by players at the table when a new session is started,


http://www.acbl.org/
http://www.bridgemate.us/
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- set to scan for available Sections. For example: A=1 D=2 (Enter 1 for Section A or 2 for Section D)
See Chapter 5, page 21 — Activating the Bridgemate.

3. The default RF (radio frequency) channel is 0. If you experience transmission troubles with this channel,
change to another channel. The channel selected in BCS for the Server must always be the same as the
one set in all the Bridgemates. The frequency range for North America is 902 ~ 927 mHz.

Note: Bridgemates automatically shut off power when not in use. Batteries need not be removed when not in use.

In the upper left corner of the Bridgemate Il screen there is a small battery indicator. Full batteries are
indicated with a full indicator. If the battery power is extremely low, the battery indicator will show an empty
battery and the indicator starts blinking. Although it is safe to continue using the Bridgemate for several
more sessions, it is recommended that the batteries be replaced as soon as possible.

The average battery life is approximately 400~500 sessions. However, this depends largely on the length of
each session, the time frame over which these sessions are played, and how the Bridgemates are stored.
Make sure no keys are pressed during storage.

The Bridgemate Scoring System is now ready to be used with ACBLscore.

ACBLscore Setup

o ? Help/New & Utilities @

When the background screen is green, the program is in Club Mode # 5ot Fath
and Game Options will be visible. If the screen is pink and/or Game g% =,
Options is not visible, switch to Club Mode (from Tournament mode). & zournanent/ciub Hode »

Enable Brldgem ate fUﬂCtIOﬂa'lty ion W74 08/13/2007 Copyright [c) 1991 €1 AL1ow Remote score entry
Go to: Setup > Game Options It is recommended that all 3 options be selected.

Set Bridgemate Options in ACBLscore

It is recommended that Bridgemate options be configured in BCS for control by the scoring program — ACBLscore.
Once the Bridgemate options have been set, they will be used for all future games — until changed.

When a game is first “opened,” press F11 to display the Typical club game options are shown here
“Select Command” screen. Left click on “BMO Remote Options”
or highlight the line and press ENTER. P RIEeer i elpIa e er=E feTacts

~ Ewery player must enter a player number
= Auto Strat when pesting names from remote
# Show previous results of the board just played
Maximum results to show (0-127, 0= unlimited) 0
# Show your own result in the list of previous results
# Enable the possibility to repeat the results
~ Show the percentage on the board just played
# On = Show score from perspective of declarer. Off = N-5
# Show pair numbers in the round info screen
# Verify the board number on correct order of entry
# On = North American results entry method, Off = European
% On = Show contract as letters, Off = symbaols
Remote auto power off time (5-60) 20
Verification message display time (1-7)) 1
Fress F9 when done
OK | Cancel|

[ e SCORGAMITR 1070704 [4).

Be E3 Yem St et

)

|

020534 {A) - F11 or AL for Comenand list CuiA to Add & secion
Hirw P Ho Sochons desnod CLUE mode

Friraes. e Hormow

WSCORE Virsion W7 43 08/1 2007 Copyright (¢} 1591-2007 ACBL

Set up a Game
Press ENTER for No

1. With the BCS program already in- ahie nuriber
stalled, create the game file and set

up sections in the normal manner.

Use Remote Server for score entry

P q '
3 Travelers - Sequence by N-5 pair number

Special considerations are:
Pick-ups should be: “Sequence by table number”
Click “Yes” or use cursor key to highlight “Yes” and press ENTER to "Use Remote Server for score entry”

2. ACBLscore automatically interrupts “posting” as of the penultimate (next-to-last) round to accommodate
preparing a one-round-to-go report. After all results for the next-to-the-last round have been posted, one or
more additional ACBLscore “post” commands will be needed to complete a game.
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3.

4,

To set up a new game (especially with multiple sections) in ACBLscore more quickly, you may bypass event
rating. See Quick Setup Tips on page 38.

s S I s BSOS A Y L 1 s i i

When a” SeCtionS are set Up, start BCS SOftWﬂre. Emg g?;risgg;ﬁitz?sw’:{eerr—ﬁgseet server - beginning of session
e Bridgemate commands are at the “end/bottom” of the BMR  Restart Remote server - do NOT reset server
The Bridg t d t th d/bott f th
F11 commands; scroll down, or press the End key. N B e
. . . B BMO R te Opti ~
BMO is used to set Bridgemate options. Note that these basic s
“Bridgemate options” may alternatively be controlled in BCS, = Core | Hob |

The BMS command is only used to start a new game/session. This will RESET the BCS software, server
and Bridgemates — erasing movement information as well as previous settings.

The BMR command is used to “restart” BCS without losing data already entered. This may happen when
the PC has been stopped, e.g., due to a power failure, PC reboot, or any other reason for BCS being shut

down during a session. There is no loss of data when BMR is used to restart the Bridgemate software.

Special note: If Bridgemate use was not enabled as shown in item 1 above, BME Enable this section for Remote
there will be a BME command visible. This should be used to “enable” the EML  Locate Remote server

# BMO Remote Options

QK Cancel

Bridgemate Scoring System for each section in the game.

Read data from the Bridgemate Scoring System into ACBLscore.
» The ACBLscore screen is normally visible on the PC, and the BCS screen is minimized.
» When you first key F11 (or F9) the keyboard may appear to be inactive. Use the mouse (or touch pad) to

move the cursor within the ACBLscore screen and left click. This will normally enable/activate the keyboard.

Player Numbers

If Player Numbers are to be entered at each table, this will be done as each table starts to use a Bridgemate.
After play has started, names are read from the result (.bws) file into ACBLscore — using the BMN command.
KeyF11 > B> M > N -or- F11 - End & highlight the BMN command line; Press ENTER
Special Note: In multi-section games the BMN command must be issued separately for each section.

ACBL Life Members enter their alpha character as a number. J=1, K=2, L=3, M=4, N-5, 0=6, P=7, Q=8 &
R=9. A “Life Master ACBL Alpha = Number” file is on the Bridgemate Flash D rive. There is a Life Master
ACBL Alpha=Number label on the bottom of each Bridgemate.

Non ACBL member “pseudo” numbers: When there are regular players who are not ACBL members, each
non-member may be assigned a pseudo number that may be used. Pseudo numbers are in the ACBLscore
database preceded by the “#” character. For example: Player number 19 will be “#19” in the database.

For each number found in the “Club” or “Tournament” database, the player’s name will be entered into the
Player Names (F3) file. If a number (ACBL member or pseudo) is not found — or no number has been
entered — there will be no entry made in the file for that player.

The BMN command will be available whenever ACBLscore’s Bridgemate Options is configured to “Allow
entry of player numbers at remote.” ACBL member numbers as well as hon-member “pseudo” numbers are
read into ACBLscore and entered in the Names (F3) file. The BMN command must be executed separately
for each Section in a session. If the ‘Auto Strat when posting names from remote’ option is checked, a strata
will be assigned to each pair based on the players masterpoints in your ACBLscore database; otherwise all
names (read in from Bridgemate) are entered in the Names file as strata “A” until the STRAT command is
run. The F11 - STRAT command is used to assign the correct strata to each pair.

Note: Use the F3 command to manually enter the names of new players and those without a number.

Use the up-arrow key to move into the player name field when there is only one player in a pair.

Before or after the “auto stratify,” manually enter the names of players not shown in the Player Names file.
With “Allow Auto Strat” — see page 36 — you will be prompted to confirm the strata for each pair.

Note: There is a detailed write-up on our website www.bridgemate.us - How-To Guides - Names Display at

Table > Names Display. This covers names display for Rover and some external movements.

View player numbers and names:

When ACBLscore is shown as the scoring program and the “Load player database after BMS command” is
checked (See Chapter 3, Scoring Programs, page 17), numbers entered by the players and the
corresponding names from the ACBLscore database will be shown on the BCS screen — “Players” tab.


http://www.bridgemate.us/
http://www.bridgemate.us/media/downloads/names-display-at-table.pdf#Display
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Board Results

Once boards have been played and the results recorded on Bridgemates, the information may be “posted”
into ACBLscore. Typically, results are not posted until play is in the last round; ACBLscore will stop posting
as of the penultimate round in order to print one-round-to go reports. Then results are posted (into
ACBLscore) again after the game has been completed so that ACBLscore can display the final results

The BMP command (F11 followed by B-M-P — or “End”) is to read board results from Bridgemate and post
them into ACBLscore. Posting will automatically stop at the end of the penultimate round — to accommodate
the preparation of a next-to-last round report. After the penultimate round has been posted, one or more
additional “post” commands are needed to read all of the final results. Ctrl-P is a shortcut for this command.

Select score posting option

When posting results in a multi-section session you will see:

1 Post all sections configured for remote entry 1 Post 3 qured for re

2 Post only Section x 2 Post anly Section C

If you wish to post only scores for the “active” session, Lancel
- click on “2 Post only Section C” and click OK, 1 P e —
- press “2” and press Enter, or CLUB mode

- use the arrow keyS to h|ghl|ght the line and press ENTER. 2=5cores F3=Names F4=Leaders Fh=Recap F7=Change Fi=List F3=5et

Otherwise just press ENTER to post scores for all sections.

The ACBLscore screen displays the number of rounds whose scores have all been posted. After all of the
rounds being played are shown as “entered,” the section/game is over. Results and reports can be
displayed and printed using F4, F5 and/or F8 as desired.

Before a score has been accepted, the TD MENU can be used to separately assign an arbitral score [AVG —
(40%), AVG = (50%) or AVG + (60%)] for E/W and for N/S. Note: The cursor must first be on the Contr line.

Scores already accepted/recorded in a Bridgemate — but not yet posted into ACBLscore — can be corrected
using the TD Menu. See Erasing entry, chapter 5, page 27. Activate the TD Menu, press ‘3 Erase result,”
enter the board number and press OK. If the board has been played more than once at this table, you will be
prompted to enter the round number. The erroneous result is erased and players may enter the correct one.

Scores already posted into ACBLscore must be corrected there. TO erase a score in ACBLscore — type “x
See page 24 for Special entries: Pass-out and board not played.

Quick Setup Tips

Early game/session setup:
Single or multi-section games/sessions may be set up early in ACBLscore. Extraneous information such as
expected movement, Event rating (stratification criteria), Event Information (Tournament data), etc., may be
entered before the stress of actual play being started. It is suggested ACBLscore be “preset” with fewer tables
than are actually expected in a single or multi-session game/session. Do not start BCS at this time.

Then, when play is ready to start:
a.

b.

To setup a session (with one or more sections) more quickly, bypass the
masterpoint portion of normal setup. Just select “13 No masterpoints.”

Use F9->5 Change movement parameters and change to the actual Select option (ESC to Exit)
movement/tables/etc. Change posting method
In a multi-section session, repeat the F9>5 Change movement gz::gg 2;";&?&2'&;’:&;%2?;
parameters for each section. o Oualift_ilcatiunfEl

After the all the movement[s] have been finalized, use F11>BMS to TR ———————
start BCS — and the session. Factorto a different average
sSettie-hreaking spread

_Later, after play has started, use “F9->10 Set

LS IID RTINS masterpoint rating to create stratification for the

U asigsunianuieap yae
9 Change scoring

methad game/sections.

isterpaint rating
nilckhanma e bhoos QTR
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Change Movement after Game has started

To the extent possible, each session/game should be as fully configured as possible in ACBLscore before starting

BCS. Movement changes can be made in ACBLscore after the BCS program has been started — to accommodate
the arrival of new player[s] or one-or-more “no show” players. The ACBLscore manual more fully describes how to
make changes.

Use F9->5 Change movement parameters. After the new parameters have been entered and accepted, ACBLscore
will automatically invoke a command to update the result (.bws) file and effect the changes in BCS.

Always post all scores before making any movement changes in ACBLscore — especially if adding pairs,
reducing rounds to play or using EDMOV; post all scores using ‘F11=>BMP’ or Ctrl-P — before making any
changes. Thereis an EXCEPTION, however, if the game was started with full tables but there is actually a
15 table and some boards have been played before making the change to the actual ¥z table in ACBscore.
Make the change to the actual Y2 table in ACBLscore BEFORE posting any results. Then go to BCS =2
Synchronize/Recover and Close Rounds —to the round before where they are actually playing at the tables.

Note: When BCS is updated, there will normally be a “Report” 4 Report
screen displayed. This screen may “closed” or BCS will Hovenent vpdated by external progran -
automatically close it after 1 minute. Delaring old movement dara sestion & - cabla 1: OF
Adding round 1: 0K
When ACBLscore updates BCS, “deleted” table[s] or section[s] Rading o 5
sometimes are not actually be removed. Thus, it is recommended Aiding sound £1 O
that any “deleted” table[s] and/or Section[s] be manually Mading roumd 7. o®
deleted/logged off in BCS to preclude possible confusion if someone Sating roumd 51 0w
inadvertently activates a deleted-table or deleted-section Bridgemate. ety mat e Saa sectien & - table 20 K
Mty rownd 2 OR 2
Change before any Bridgemates have been used -

When the changes can be made before players have started entering
their member numbers and/or results, instruct players to delay any entries until the changes are made. After the
ACBLscore changes have been made and BCS has been updated, players may begin normal Bridgemate use.

Change after people have started member number and/or score entry

Ask players to hold up any further Bridgemate entries until the movement change has been completed.

If the movement change will move pairs around, player numbers will need to be entered manually, later. However, if
pairs remain at the same tables (even though they may now have different team numbers, e.g., when change from a
5 table Howell to a 6 table Howell, or a 6 table Howell to a 7 table Mitchell, ACBLscore BMN (Post Names from
Bridgemate) will correctly assign pairs to the correct tables — when the “member-number” option is being used.
Make the movement changes as noted above. ACBLscore automatically updates BCS with the new info.

Note: When BCS is updated, there will normally be an “update” screen displayed.

Replacing Bridgemate during play — Bridgemate logged on as the wrong table
See page 32 Replacing Bridgemate or See page 32 Bridgemate logged on as the wrong table

Procedures when using Player entry of Section/Table

Check each Bridgemate as it is placed on a table. Press the OK key; if the "Bridgemate II" screen appears, the
unit is ready for Section/Table input. If the display is anything other than "Bridgemate 1l," reset the Bridgemate.

Swiss Teams and Knockouts

ACBLscore does not support using the Bridgemate wireless scoring system for team events. There is third-party
software that may be used for team games. The final results are then entered manually into ACBLscore. Detailed
information is available on the Bridgemate.US website: www.bridgemate.us - How-To Guides > Team Games
using Bridgemates



http://www.bridgemate.us/
http://www.bridgemate.us/how-to-guides/team-games-using-bridgemates/
http://www.bridgemate.us/how-to-guides/team-games-using-bridgemates/
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Names Display for 1° Round Sit-out Pair[s]

For more information, see Chapter 6 Showing player names.

Starting with BCS v3.1.2 there is an option on the BCS - Tools - Options - General - Scoring Program page:
Sit-out:

v Carrect missing sit-out pait number at half table inround 1 - 1L may be checked (for normal Mitchell & Howell movements)

and should obviate the need to use an alternate procedure. Rover movements require special procedures for
displaying the Rover pair names. See the “Names Display at Table” write-up on the Bridgemate.US website
www.bridgemate.us > How-To Guides.

Special Note — Howell Movement: The phantom pair must be EW — at Round 1 — in order for the NS sitout pair
names to display properly.

Special Reports

Play data may be copied from BCS and used to prepare special reports — such as a summary of the results of each
board played.

.
e See Creating Reports, Chapter 3, page 12 on how to copy play data

from the BCS screen. Tahle size

Murnber of colurnns: 7 T
e EXCEL spreadsheet:
o0 Paste the copied data into an Excel Spreadsheet.
o With the new data highlighted, select Data - Text to Columns
Select “Comma” as the delimiter.

Mumber of rows:

AutoFit behavior

Or

¢ WORD document: ) utoFit to window
o Paste the copied data into a Word document. Table style: (none)
o Highlight the new data, select Table > Convert > Text to Table Separate text at
Complete the “Convert Text to Table” screen as noted for O Paragraphs (&) Commas
“Commas,” “AutoFit to contents” and number of columns in your O Tabs O other:
data (7 is shown here).
0 The table that is created will be highlighted. Select Table > [ o ][ caneel

Convert > Table to Text. This creates text which may be pasted
into an email message or uploaded to a website.

e OpenOffice.org: A simpler procedure is to use the spreadsheet program of OpenOffice.org which is “free to
download, use, and distribute” at http://download.openoffice.org/
o Paste the copied data into the OpenOffice.org calc spreadsheet. On the “Text Import” screen that will
ai under “Separator options” and click OK.
0 Adjust column widths — if desired.
o Highlight and copy the data for your report.

e EXCEL spreadsheet — alternate procedure (advanced Excel user): There is an alternate procedure whereby
data can be “imported” into Microsoft® Excel from the game’s .bws data file.
0 Change the file suffix on the game data file from .bws to .mdb (e.g, 130615A.bws > 130615A.mdb).
This file is normally in the C:\ACBLSCOR\GAMEFILE folder.
In Excel: Data - Get External Data - From Access - find & select the renamed .mdb file
A “Select table” window will appear. Highlight the “Received Data” table and click OK.
On the “Import Data” window select “Table” and “Existing worksheet” - Click OK
The “Result” column will be in the European “Up/down tricks” format. To create an “American style”
Results column use an Excel formula — such as this:
=IF(K2="="LEFT(J2,1)+0,IF(LEFT(K2,1)="-",(K2+0),LEFT(J2,1)+K2))
Highlight and copy this new “result” column; then paste it as “values” into the “Result” column.
Delete un-needed columns.

(el el elNe)

o O

Special Note: Excel 2016 will not open a .bws file — even after renaming it to .mdb. Use an
earlier version of Excel.


http://www.bridgemate.us/
http://download.openoffice.org/
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It is suggested the BCS column heading “NS/EW” be changed to Declarer. Below is a sample report. Note: This
example includes the “Lead” card which may be captured when options are controlled by BCS.

Section Board NS EW Declarer Contract Result Lead
A 1 2 3 N 4 H -2 H4
A 1 3 5 N 4 H -2 H4
A 1 4 7 S 3 NT -1 SJ
A 1 5 9 N 3 H -1 H4
A 1 6 2 S 3 NT -3 DA
A 1 7 4 N 4 H -1 c2

Expanded detail available on Websites.

With the Bridgemate Scoring System more detail is available about each board than the limited information from
ACBLscore. The Declarer, Contract and actual result — when coupled with ACBLscore info — provides players with
more information than ever before. The detail is even more significant with pre-dealt hands using a dealing machine
— or the analysis of player-entered boards when using BCS version 2.8.29 (or later).

Bridgemate.US has been working with three bridge-specific websites that are easily set up and controlled by a non-
programmer. Our test sites are: www.waynesboro.bridge-club.org, www.bridgewebs.com/waynesboro/ and
http://site.pianola.net/wintergreen-bridge/. Visit www.bridge-club.org or www.bridgewebs.com or www.pianola.net to
review their offerings and pricing. All three offer a trial period.

Several clubs/units have developed their own website-display software. Also, ACBL offers a “Clubs Results” service
to ACBL sanctioned clubs. When a game is finished, it is very easy to upload 2 files (3 — with hand records) and the
result is immediate. More information is on our website www.bridgemate.us/product/website-displays/

Using Bridgemates Il and Bridgemates Pro together

If you have both a Bridgemate Pro and a Bridgemate Il system, it is possible to use both systems together to score a
single event. As Bridgemates Il only communicate with a Bridgemate Il USB server and Bridgemates Pro only with a
Bridgemate Pro ‘serial’ server, it is a requirement that both servers are connected to the computer.

To use both Bridgemate Pro and Bridgemate Il in one event:

1. Connect both a Bridgemate Il USB server and a Bridgemate Pro serial server to your computer. The
Bridgemate Pro server can be connected through the USB-to-serial “dongle.” Please refer to the Bridgemate
Pro manual for operating instructions of the Bridgemate Pro server.

2. Start the Bridgemate system from your scoring program. This will start the Bridgemate Il system first.

3. After BCS has been loaded and Bridgemates Il have been activated, click on Session - Run Bridgemate
Pro concurrently. This will load a second copy of BCS and this copy will start the Bridgemate Pro server.
Both systems may now be used together.

4. When the session is finished, manually close both instances of BCS.

Please keep in mind the following when working with both systems together:

o All tables will be loaded into the Bridgemate Il server and the Bridgemate Pro server. You decide which
tables will use Bridgemates Pro, and which will use Bridgemates Il. As a consequence, the Bridgemate “II
BCS” and the “Pro BCS” will show that certain tables are not activated yet in the 1l or Pro server, since these
units are logged into the other server.

e You may wish to use Bridgemate Pro’s and II's in separate sections, e.g., Section A uses Bridgemates |l,
and Section B uses Bridgemates Pro. However, the units may even be “mixed” within a Section.

e Scores are exchanged between the two systems. Scores entered in Bridgemate Pro will also appear on the
Bridgemate Il scoring devices, and vice versa.

e A scoring-program movement update will first be carried out by Bridgemate Il, and a few seconds later by
Bridgemate Pro. This is done automatically.

e If the second instance of BCS is accidently closed, it can be started again by using the same BCS menu:
Session = Run Bridgemate Pro concurrently. It will remember that it has already been started before and
will not start from round 1 but instead continue from where it was when the program was closed.

e Since Bridgemate Il has more settings than Bridgemate Pro, Bridgemate Pro will only use those settings that
are for Bridgemate Pro. For example, names may appear on Bridgemates Il but will not on Bridgemates Pro.


http://www.waynesboro.bridge-club.org/
http://www.bridgewebs.com/waynesboro/
http://site.pianola.net/wintergreen-bridge/
http://www.bridge-club.org/
http://www.bridgewebs.com/
http://www.pianola.net/
http://www.bridgemate.us/product/website-displays/
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Declaration of Conformity

Federal Communication Commission Declaration of Conformity (DoC) Statement

Responsible party: Bridge Systems BV

Address: Postbus 21570, 3001 AN, Rotterdam, The Netherlands
Hereby declares that the product:

Product Name: Bridgemate® Il Wireless Scoring System .

Table Terminal: I Model No: BM2-1 FCC ID: UviBM21

Server: UsB -l Model No: BMS2-1  FCC ID: UVIBMS21

Conforms to the following regulations: FCC part 15, subpart B, section 15.47

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15
of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
e Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) This device must accept any interference received, including
interference that may cause undesired operation.

Caution:
Any changes or modifications not expressly approved by Bridge Systems BV could void the user's authority to
operate the equipment.

Canada Regulatory Compliance Statement

This device complies with Industry Canada Standard RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

Ce dispositif est conforme avec la norme CNR-210 d’Industrie Canada. Le fonctionnement du dispositif est sujet aux
deux conditions suivantes: (1) le dispositif ne doit pas causer de brouillage, et (2) le dispositif doit accepter tous
brouillages, incluant tous brouillages.

Table Terminal: 1 IC: 6946A-BM21
Server: USB -1l IC: 6946A-BMS21
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